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Warranty
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in future editions. Further, to the max-
imum extent permitted by applicable 
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Technology Licenses 

The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of 
a U.S. Government prime contract or sub-
contract, Software is delivered and 
licensed as “Commercial computer soft-
ware” as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as “Restricted 
computer software” as defined in FAR 
52.227-19 (June 1987) or any equivalent 
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commercial license terms, and non-DOD 
Departments and Agencies of the U.S. Gov-
ernment will receive no greater than 
Restricted Rights as defined in FAR 52.227-
19(c)(1-2) (June 1987). U.S. Government 
users will receive no greater than Limited 
Rights as defined in FAR 52.227-14 

(June1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data.

Safety Notices

 A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met.

A CAUTION notice denotes a hazard. It 
calls attention to an operating procedure, 
practice, or the like that, if not correctly 
performed or adhered to, could result in 
damage to the product or loss of important 
data. Do not proceed beyond a CAUTION 
notice until the indicated conditions are 
fully understood and met.
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Preface
This preface contains the following topics:

• “About this guide” on page vi

• “Accessing Automation Solutions user guides” on page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide describes the BioCel System, the operation of the hardware 
components, and the use of the diagnostics software.

This guide does not provide instructions for the following:

• VWorks software or third- party software

• Agilent Technologies devices, such as the Bravo Automated Liquid Handling 
Platform, PlateLoc Thermal Microplate Sealer, Microplate Seal Piercer, 
Microplate Labeler, Vertical Pipetting Station, Microplate Centrifuge, and 
Labware Stacker.

• Third- party devices

For more information about these topics, see the relevant user guides for these 
products.

What’s new in this guide

                                                        

Job role Responsibilities

Installer Unpacks, installs, and tests the BioCel System before it is 
used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
BioCel System

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the BioCel System 
and solves routine problems.

Feature and description See

Device file – You can now disable up to 
10 devices within a single device file

“Disabling a device in a device 
file” on page 35
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Related guides

The BioCel System User Guide should be used in conjunction with the 
following user documents:

• BioCel System Safety Guide. Describes the potential safety hazards on the 
BioCel System and how to avoid them. Explains the emergency- stop 
procedure and the recovery methods.

• Automation Control Unit User Guide. Explains how to install, set up, and 
operate the Automation Control Unit.

• BioCel Environmental- Control System User Guide. Describes the 
Environmental- Control System in the BioCel System, the operation of the 
relevant hardware components, and the use of the iSeries Diagnostic 
software.

• BenchBot Robot User Guide. Explains how to set up and operate the 
BenchBot Robot.

• Direct Drive Robot User Guide. Explains how to set up and operate the 
Direct Drive Robot.

• Lab automation software user documentation. Explains how to define 
labware, add devices, and create protocols.

• Automation Solutions device user guides. Explain how to set up and use 
the Automation Solutions device.

• Third- party device user documents. Explain how to set up and use third-
party devices.

For site preparation and installation requirements, see the site- specific 
documentation provided by Automation Solutions. The site- specific documents 
address different system configurations and requirements. If you have 
questions, contact Automation Solutions Technical Support.

The 3- Axis Robot, Peak KiNEDx Robot, BioCel I/O Interface, Microplate 
Conveyor, Microplate Shuttle, and Rotator are no longer supplied with the 
BioCel System. However, if you have these devices in your existing system, you 
can find information about the devices in the BioCel System User Guide, 
Revision 01, August 2010.

Related information

                                                        

For information about... See...

Accessing related user guides “Accessing Automation Solutions user 
guides” on page viii

Reporting problems “Reporting problems” on page 69

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90003_BioCelECUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation. 

Accessing safety information

Safety information for the BioCel System is provided in the BioCel System 
Safety Guide.

Safety information for the Agilent Technologies devices appears in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/lifesciences/automation
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Related information

For information about... See...

Who should read this guide “About this guide” on page vi

What this guide covers “About this guide” on page vi
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BioCel System overview

This chapter contains the following topics:

• “BioCel System description” on page 2

• “Hardware overview” on page 5

• “Device integration options” on page 20

• “Software overview” on page 21
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BioCel System description

Description

The BioCel System is a laboratory automation platform that:

• Stores labware (microplates, tip boxes, tube racks, and others) that will be 
processed during a protocol run.

• Moves labware to and from devices for processing. The devices are 
integrated in the BioCel System and controlled by the VWorks software. 
For a list of the devices that you can integrate in the system, see “Device 
integration options” on page 20.

You can use the BioCel System for applications such as compound 
management, PCR sample preparation, cell- based assays, ADME- Tox assays, 
high- throughput screening, and so on.

Three models of the BioCel System are available: BioCel 900 System, BioCel 
1200 System, and BioCel 1800 System. An environmental- control option can be 
added in the two larger systems (the BioCel 1200 and 1800 Systems) to create 
fully contained, contaminant- free environments.

Components

All three BioCel System models consist of the following components: Main 
body (1), computer (2), and VWorks software (not shown). In a system where 
multiple BioCel units are connected, only one computer is typically provided.

BioCel 900 System
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BioCel 1200 System

BioCel 1800 System

1

2

1
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Before you operate the system

Related information

WARNING  For safe operation, it is imperative that you become familiar with the 
information in the Automation Control Unit User Guide and follow the precautions in the 
BioCel System Safety Guide.

For information about... See...

BioCel System features “Hardware overview” on page 5

Device integration options “Device integration options” on page 20

Additional devices “Additional BioCel System Devices” on 
page 71

Software that controls the BioCel 
System

“Software overview” on page 21

Safety information BioCel System Safety Guide

Automation Control Unit Automation Control Unit User Guide
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Hardware overview

About this topic

This topic describes the following BioCel System hardware features:

• Safety equipment

• Electronics cabinet

• Environmental Controls panel (in some BioCel 1200 and 1800 Systems)

• Liquid management components 

• Air distribution panel

• Direct plumbing and external utilities connections (optional)

• Robot

• System status indicators

• Hood and deck light switch

• Barcode reader power supply (optional)

• Trash door and chute (optional)

• Docking tables (optional)

Safety equipment

The following safety equipment is supplied with the BioCel System:

• Emergency- stop pendants (all system models)

• System doors (BioCel 1200 or 1800 System only)

• Light Curtain (BioCel 900 System only)

• Removable windows on docking tables

Emergency-stop pendants
Emergency- stop pendants are supplied with every system and installed outside 
of the danger zone. To stop the system in an emergency, press the red button 
on the emergency- stop pendant. The robots and devices stop immediately, 
regardless of whether the INTERLOCK key switch is set at NORMAL or 
BYPASS.

For more information about stopping the system in an emergency, see the 
BioCel System Safety Guide.

System doors
Depending on the configuration, either sliding doors or flip- up doors are 
installed in the BioCel 1200 System or BioCel 1800 System. Typically, flip- up 
doors are installed in systems that require environmental control.
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The sliding doors and flip- up doors are part of the safety interlock circuit that 
must be closed for the system to operate. Designed to protect you from 
moving- part hazards while the system is in operation, opening a door will 
open the safety circuit, stop the motion of the robots, and pause the run.

IMPORTANT You cannot open doors of inert environment systems until the 
gas is purged.

For detailed safety information, see the BioCel System Safety Guide.

Light Curtain
The Light Curtain is part of the safety interlock circuit that must be closed for 
the BioCel 900 System to operate. Designed to protect you from moving- part 
hazards while the system is in operation, interrupting the Light Curtain will 
open the safety circuit, stop the motion of the robots, and pause the protocol 
run.

A Light Curtain post is located at each corner of the BioCel 900 System.

For detailed safety information, see the BioCel System Safety Guide.
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Removable windows on docking tables
Some docking tables have protective windows that are connected to the safety 
interlock circuit and function like system doors. Designed to protect you from 
moving- part hazards while the system is in operation, opening a window will 
open the safety interlock circuit, stop the motion of the robots, and pause the 
run.

Instead of connecting to the safety interlock circuit, some protective windows 
have locks to prevent operators from entering the system while the robots and 
devices are in motion. The protective window should be locked during system 
operation.

For detailed safety information, see the BioCel System Safety Guide.

Electronics cabinet

Electronics cabinet components
The electronics cabinet is located below the system deck and contains the 
following:

Item Components Description

1 Automation Control 
Unit

Distributes power, provides emergency- stop 
and safety interlock functions, and controls 
device communication. For more 
information, see “Automation Control Unit 
features” on page 8.

2 Robot power supply Supplies AC power to the system robot.

Note: The robot power supply is only 
applicable to certain robots, such as the 
Direct Drive Robot.
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Automation Control Unit features
The following figure shows the Automation Control Unit in detail. 

3 Controlling computer Does the following:

• Runs the lab automation software and 
controls the BioCel System and 
integrated devices.

• Communicates with other computers on 
your organization’s network for file 
exchanges and email access.

The supplied computer has two Ethernet 
ports. One of the Ethernet ports connects to 
the Automation Control Unit, the second 
Ethernet port connects to your 
organization’s wide area network (WAN).

A computer monitor is supplied with the 
BioCel System and it is mounted on one of 
the frame posts.

4 UPS Provides backup power for the BioCel 
System during a power outage. The UPS is 
included in the BioCel 1200 System and the 
BioCel 1800 System, but is an optional 
component in the BioCel 900 System.

Item Components Description
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For more information about the Automation Control Unit, see the Automation 
Control Unit User Guide.

Environmental Controls panel

The Environmental Controls panel consists of switches for power and optional 
inert gas, and is located next to the electronics cabinet. Installed in some 
BioCel 1200 and 1800 Systems, the panel is a part of the BioCel 
Environmental- Control System. For information, see the BioCel 
Environmental- Control System User Guide.
                                                        

Item Feature Description

1 Power switch Turns on or turns off the AC power, DC power, 
and air supply to the system.

Note: The power switch is equipped with a 
locking mechanism that allows you to enforce 
lockout/tagout policies in your organization. For 
more information, see “Starting up and shutting 
down the BioCel System” on page 28.

2 Fuse housings Contains the fuses. For fuse ratings, see the 
Automation Control Unit User Guide.

3 Indicator lights Indicates status of the system doors, Light 
Curtain, emergency- stop button, and various 
devices connected to the 5 V and 24 V digital 
signal output ports. See “System status 
indicators” on page 14.

4 RESET button Resets the emergency- stop relay to allow 
electrical current to flow to switched power 
outputs.

For emergency- stop recovery, see the BioCel 
System Safety Guide. For indicator light 
descriptions, see “Indicator lights on the 
Automation Control Unit” on page 16.

5 INTERLOCK key 
switch

Arms (NORMAL) or bypasses (BYPASS) the safety 
interlock.

For a description of the interlock modes, see the 
BioCel System Safety Guide.

WARNING  Access to and use of the interlock key should be controlled. To avoid 
possible injury, the INTERLOCK BYPASS setting should be used only by personnel trained 
to teach the robots and devices in the system. The interlock key should be removed from 
the Automation Control Unit when the switch is set at NORMAL and you are not teaching 
robots and devices.

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90003_BioCelECUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90003_BioCelECUG_EN.pdf
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Liquid management components

The BioCel System has components that allow you to manage liquids 
transferred to and from integrated devices. For systems installed in the EU, 
liquid management components are contained in a liquid cabinet, as shown in 
the following figure. Systems that are installed outside of the EU have the 
same liquid management components, but they might be installed 
independently under the system deck.

Figure Liquid management components in the liquid cabinet

The liquid cabinet provides the following functions:

• Isolates liquid management components from the rest of the system. The 
cabinet contains adjustable pull- out shelves with trays to contain minor 
spills. Tubing and utility cords are routed through the back of the cabinet. 

1

2

Item Component Description

1 Pump Module Transfers liquids into and waste away from 
the Vertical Pipetting Station and Bravo 
accessories. The Pump Module contains two 
peristaltic pumps that are controlled using 
the lab automation software.

2 Liquid containers Contains liquids to be transferred to the 
integrated devices.

Other equipment  
(not shown)

Consists of other devices or equipment, such 
as the Weigh Pad, that are needed for your 
specific system configuration.
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• Catches minor spills from the system deck. Minor spills on the deck flow 
into the deck troughs, are routed to the spill gutter at the back of the 
liquid cabinet, and exit the system through the drain at the bottom of the 
gutter. A spill- detection sensor is located at the bottom of the spill gutter. 
The sensor can be configured to display spill notifications or pause a 
protocol when spills are detected. For instructions on setting up the spill-
detection sensor in the software, see the VWorks Automation Control User 
Guide.

IMPORTANT The spill- detection sensor is not a safety device. The sensor 
alerts you in case of spills in the system to prevent loss of materials and allow 
timely cleanup. It cannot distinguish between different types of chemicals used, 
and it does not warn you of hazardous conditions. For chemical safety 
information, see the BioCel System Safety Guide.

Figure Spill-detection sensor, located at the bottom of the spill gutter

Although not installed by default, the liquid cabinet is designed to allow you to 
add an exhaust system to ventilate vapors from the cabinet.

Direct plumbing and external utilities connections (optional)

Instead of using reservoirs and waste containers, the BioCel System can have 
direct plumbing from an external water source. Depending on the system 
configuration, the plumbing lines can enter the system at different locations. 

The connections to other external utilities can enter the system through either 
the main frame posts or at the top of the system. For more information, see 
the site- specific documentation provided by Agilent Technologies. The site-
specific documents address different system configurations and requirements. 
If you have questions, contact Automation Solutions Technical Support.
                                                        

CAUTION The liquid cabinet is not intended to be a storage cabinet and is not designed to 
comply with NFPA Code 30 or similar regulations. Do not store explosive, flammable, 
combustible, or corrosive chemicals in the liquid cabinet. For all chemicals, always follow 
safety data sheet instructions for storage, handling, and disposal.
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Air distribution panel

The air distribution panel contains air supply connections, regulators, and a 
filter. The panel is located either behind the liquid cabinet or on the side of 
the electronics cabinet.

The following figure shows the components that control the system air supply 
in detail.

Note: Depending on the options you installed, the air distribution panel might 
look different than shown in the figure.

Item Components Description

1 Delidder air- pressure regulator 
(optional)

Controls the air pressure to the 
vacuum- based lid remover.

2 System air- pressure regulator Controls the air pressure to the 
entire BioCel System.

3 Air filter Filters the air supply to the system 
and traps oil or liquid in the 
supply line.

4 Air supply shutoff valve Turns on or off the air supply to 
the system.

Use the valve to turn off the air 
supply only if the air is leaking in 
the system, and turning off the 
power switch on the Automation 
Control Unit does not turn off the 
air.

Note: A loud noise can be heard 
when you shut off the valve and 
residual air is released.

00
27
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42
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Robot

The BioCel System uses the following robots:

• BenchBot Robot

• Direct Drive Robot

BenchBot Robot
The BenchBot Robot has four axes of motion and is able to grip labware in 
both the landscape and portrait orientations.

For more information, see the BenchBot Robot User Guide.

Direct Drive Robot
The Direct Drive Robot has four axes of motion and is able to grip labware in 
both the landscape and portrait orientations.

5 Air valve actuator Turns on or shuts off the air 
supply to the system. The actuator 
is controlled by the power switch 
on the Automation Control Unit. 
Turning off power at the 
Automation Control Unit or 
pressing an emergency- stop button 
turns off the actuator, which turns 
off the air supply.

Item Components Description

9

8

10

11

Item Axis Description of robot movement

1 Shoulder The joint that connects the robot arm to the mast. 
The arm rotates 186° about the shoulder.

2 Elbow The joint that connects the bicep and the forearm. 
The forearm rotates 336° about the elbow.

3 Wrist The joint that connects the forearm to the hand. The 
hand rotates to any angle about the wrist.

4 Mast, or  
z- axis

The vertical structure along which the robot arm 
moves up and down.
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Figure Direct Drive Robot axes of movements (top view and side view)

For more information, see the Direct Drive Robot User Guide.

System status indicators

System status indicators enable you to monitor the current status of the 
BioCel System. The types of indicators that are available include:

• Multicolor status lights

• Audible alarms

• Indicator lights on the Automation Control Unit

Multicolor status lights
Multicolor status lights enable you to monitor the current status of the BioCel 
System from a distance. The lights are optional in all system models.

If installed, the status light fixture is located above one of the frame posts in 
the BioCel 1800 System and BioCel 1200 System. The light fixture is typically 
mounted on a bench in the BioCel 900 System. Different light patterns indicate 
different conditions.

1

2

3

4

Item Axis Description of robot movement

1 Waist Robot arm rotates infinitely about the waist.

2 Elbow Robot forearm rotates infinitely about the elbow.

3 Wrist Robot hand rotates infinitely about the wrist.

4 Mast Robot arm moves up and down along the mast.
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Note: In addition to the status lights, you can also monitor the status of a 
system in the lab automation software. For details, see the lab automation 
software user documentation.

Light pattern Status

 
Red = Off

Yellow = Off

Green = On

The INTERLOCK key is set at NORMAL, 
and one of the following is true:

• The system is idle.

• The system is running in error- free 
mode.

 
Red = Off

Yellow = Flashing

Green = On

The INTERLOCK key is set at BYPASS, 
and one of the following is true:

• The system is idle.

• The system is running in error- free 
mode.

 
Red = Flashing

Yellow = Flashing

Green = Off

The INTERLOCK key is set at BYPASS, 
and one of the following is true:

• The system has encountered a run 
error.

• The operator has paused the protocol 
run using one of the following 
methods:

– Clicked the Pause button in the 
software.

– Pressed the emergency- stop 
button.

Note: Opening a door or interrupting the 
Light Curtain does not pause the run 
when the interlock is bypassed.

 
Red = Flashing

Yellow = Off

Green = Off

The INTERLOCK key is set at NORMAL, 
and one of the following is true:

• The system has encountered a run 
error.

• The operator has paused the protocol 
run using one of the following 
methods:

– Clicked the Pause button in the 
software.

– Opened a system door or 
interrupted the Light Curtain.

– Pressed the emergency- stop 
button.

 
Red = Off

Yellow = Off

Green = Off

The Automation Control Unit is not 
initialized in the lab automation software 
or is turned off.
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Audible alarms
An audible alarms is available in every system model. The alarm enables you 
to monitor the current status of the BioCel System from a distance. By default, 
the alarm is configured to sound only when the INTERLOCK key is set at 
NORMAL, and under the following circumstances:

• When an error occurs during a run.

• When the operator opens a system door or interrupts the Light Curtain 
during a run.

In both cases, you can acknowledge and turn off the alarm in the software. For 
information about configuring the alarm, see the VWorks Automation Control 
User Guide.

Note: The alarm will not sound if the operator pauses the run using the 
software Pause button.

Indicator lights on the Automation Control Unit
The Automation Control Unit has lights that indicate the following:
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Name Description

DOORS • Green. Doors are closed.

• Red -  solid. One of the doors is open.

• Red -  blinking. A hardware connection error 
has occurred.

LIGHT CURTAIN • Green. Nothing is interrupting the Light 
Curtain.

• Red -  solid. An object is interrupting the Light 
Curtain.

• Red -  blinking. A hardware connection error 
has occurred.

E- STOP • Green. The emergency- stop button is not 
pressed.

• Red -  solid. The emergency- stop button has 
been pressed.

• Red -  blinking. A hardware connection error 
has occurred.

INTERLOCK • Green. The INTERLOCK key is set at NORMAL.

• Yellow. The INTERLOCK key is set at BYPASS, 
or the operator has selected Bypass Interlock in 
the Scheduler Paused dialog box.

RESET • Blue -  solid. The emergency- stop button is not 
pressed, all of the system doors are closed, and 
nothing is interrupting the Light Curtain.

• Blue -  blinking. The interlock is tripped (the 
emergency- stop button is pressed, a system 
door is open, or the Light Curtain is 
interrupted).

DC STATUS • Green -  on. The device is on.

• Green -  off. The device is off.

• Green -  blinking. The device is in the 
emergency- stop state (the emergency- stop 
button is pressed). This state is only applicable 
to devices that are connected to a post-
emergency- stop circuit (5 VDC OUT E- STOP 
and 24 VDC OUT E- STOP connections).
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Hood and deck light switch

LED lights are provided in the hood (BioCel 1200 System and BioCel 1800 
System) and under the deck (all system models) to improve the visibility of the 
devices or components in the system. The light switch is a touchpad located 
behind the computer monitor. Touch it once to turn on the lights. Touch it 
again to turn off the lights.

Barcode reader power supply (optional)

The barcode reader power supply is an optional component that supplies 
power to auxiliary barcode readers integrated in the system. The barcode 
reader power supply is located under the BioCel System deck.

Trash door and chute (optional)

The trash door is located immediately below the BioCel System table surface. 
The door slides open to allow used pipette tips or labware to fall into the 
waste bin under the table.

Docking tables (optional)

If you have applications that require periodic or frequent addition or removal 
of a device in the BioCel System, you can mount the device on a docking table. 
The docking table sits on wheels so that you can easily move it. 
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The table must be docked adjacent to the BioCel System to prevent movement 
during a protocol run. When you no longer need the device, you can undock 
and move the table.

For instructions on how to dock or undock a table, see “Adding or removing 
devices mounted on docking tables” on page 41.

Related information

For information about... See...

BioCel System description “BioCel System description” on page 2

Additional BioCel System devices “Additional BioCel System Devices” on 
page 71

BioCel System software “Software overview” on page 21

BioCel System specifications Site- specific documentation provided by 
Automation Solutions

Safety information BioCel System Safety Guide

Automation Control Unit Automation Control Unit User Guide

3- Axis Robot BioCel System User Guide, Revision 01, 
August 2010

Peak KiNEDx Robot BioCel System User Guide, Revision 01, 
August 2010

Staubli Robot Staubli TX60 Device Driver User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Device integration options

About devices

Devices are individual pieces of equipment that are integrated in the BioCel 
System. Devices can store or process labware.

Agilent Technologies devices

Agilent Technologies devices that can be integrated in a BioCel System include:

• Bravo Automated Liquid Handling Platform

• PlateLoc Thermal Microplate Sealer

• Labware MiniHub

• Labware Stacker

• Microplate Centrifuge

• Microplate Seal Piercer

• Microplate Labeler

• Vertical Pipetting Station

For details on how to set up these devices, see the user guide for the device.

Additional devices can be integrated in the BioCel System. For the list of 
additional devices, see “Additional BioCel System Devices” on page 71.

Third-party devices

Many third- party devices can be integrated in a BioCel System. For a 
comprehensive list, contact Automation Solutions Customer Service.

If you would like to add other devices to the BioCel System, contact 
Automation Solutions Customer Service.

Related information

For information about... See...

BioCel System description “BioCel System description” on page 2

BioCel System hardware features “Hardware overview” on page 5

Additional BioCel System devices “Additional BioCel System Devices” on 
page 71

BioCel System software “Software overview” on page 21

BioCel System specifications Site- specific documentation provided by 
Automation Solutions.

Safety information BioCel System Safety Guide
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Software overview

About this topic

You use the lab automation software and device diagnostics plugin to set up, 
run, and troubleshoot the BioCel System. This topic describes the VWorks 
software and robot diagnostics software. For information about the diagnostics 
plugin of an integrated device, see the device user guide. For information about 
other lab automation software, see the user documentation for the software.

VWorks software

The VWorks software allows you to:

• Set up the BioCel System. During setup, you need to create a device file 
for the BioCel System robot and integrated devices. For setup information, 
see “Setup Workflow” on page 24.

• Set up user accounts and privileges. You can set up different user 
accounts to enforce access policies. For instructions, see the VWorks 
Automation Control Setup Guide.

• Define labware. Labware definitions describe the labware you will use 
during protocol runs. For instructions, see the VWorks Automation Control 
Setup Guide.

• Create protocols. Protocols determine the sequence of tasks you want to 
automate in a run. For example, you can use a protocol to apply barcode 
labels to 100 microplates. For protocol- writing instructions, see the VWorks 
Automation Control User Guide.

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, 
and stop a protocol run from the controlling computer.

For a full description and instructions on how to use the VWorks software, see 
the VWorks Automation Control User Guide.
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Robot diagnostics software

Accessed through the VWorks software, the robot diagnostics software allows 
you to:

• Create and manage profiles. Robot profile allows you to set up 
communication between the robot and the controlling computer. You create 
the profile when you set up the system. For setup information, see “Setup 
Workflow” on page 24.

• Set and edit teachpoints. Teachpoints are locations that the BioCel System 
robot will go to and from during a protocol run. You set teachpoints when 
you set up the BioCel System. You can also edit the teachpoints to correct 
or fine- tune the original teachpoints. For teachpoint setup and editing 
information, see “Setup Workflow” on page 24.

• Diagnose problems. Moving and adjusting individual hardware components 
allow you to diagnose and troubleshoot problems. For information on 
diagnosing and troubleshooting problems, see the robot user 
documentation.

The diagnostics software you use depends on the robot installed in the system. 

• If the BioCel System has the BenchBot Robot, see BenchBot Robot User 
Guide.

• If the BioCel System has the Direct Drive Robot, see Direct Drive Robot 
User Guide.

Related information

For information about... See...

VWorks software instructions VWorks Automation Control User 
Guide

BioCel System description “BioCel System description” on page 2

BioCel System specifications BioCel System Site Preparation Guide

BioCel System hardware features “Hardware overview” on page 5

Additional BioCel System devices “Additional BioCel System Devices” on 
page 71

Devices that can be integrated in 
the system

“Device integration options” on page 20

Safety information BioCel System Safety Guide

3- Axis Robot BioCel System User Guide, Revision 01, 
August 2010

Peak KiNEDx Robot BioCel System User Guide, Revision 01, 
August 2010

Staubli Robot Staubli TX60 Device Driver User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Setting up the BioCel System

This chapter explains how to set up the BioCel System for 
operation. This chaptercontains the following topics:

• “Setup Workflow” on page 24

• “Adjusting the keyboard shelf and computer monitor” on 
page 26

• “Starting up and shutting down the BioCel System” on page 28

• “Adding and deleting devices in the software” on page 32
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Setup Workflow

About this topic

This topic presents the workflow for setting up the BioCel System for 
operation.

Workflow

The following table presents the steps for setting up the BioCel System. After 
setting up the BioCel System for the first time, you will not likely change the 
setup unless you add a device, replace a device, or move the BioCel System.

IMPORTANT Before proceeding to step 5 (setting teachpoints), you should 
already have definitions for the labware you want to use. Although you can 
define labware at any time, Agilent Technologies recommends that you define 
labware before setting up the BioCel System. For instructions on how to define 
labware, see the VWorks Automation Control Setup Guide.

Step For this task... See...

1 Adjust the keyboard shelf. “Adjusting the keyboard shelf and 
computer monitor” on page 26

2 Start up the BioCel System. “Starting up and shutting down the 
BioCel System” on page 28

3 Create a device file and add 
devices in the software.

“Adding and deleting devices in the 
software” on page 32 or device 
user guide

4 Create a profile. One of the following:

• Robot user documentation

• Automation Solutions or third-
party device user guide

• “Additional BioCel System 
Devices” on page 71

5 Set and edit teachpoints for 
integrated devices.

One of the following:

• Robot user documentation

• Automation Solutions or third-
party device user guide

• “Additional BioCel System 
Devices” on page 71

6 Write protocols. Lab automation user 
documentation, such as the VWorks 
Automation Control User Guide
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Related information

For information about... See...

Operating the BioCel System “Checking for system readiness” on 
page 50

Troubleshooting problems “Maintenance and troubleshooting” on 
page 55
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Adjusting the keyboard shelf and computer monitor

About this topic

This topic explains the following:

• Adjusting the keyboard shelf height

• Adjusting the monitor tilt angle

Adjusting the keyboard shelf height

To adjust the keyboard shelf height:

1 Swivel the keyboard shelf away so that you have access to the height-
adjustment lever.

2 Have one person hold and support the weight of the shelf.

3 Turn the height- adjustment lever counterclockwise to unlock the shelf from 
its current position. The shelf can now move up and down freely.

                                                        

WARNING Because the keyboard shelf is very heavy, the height adjustment procedure 
requires two people. One person will turn the lever to unlock the keyboard shelf from its 
current position. Another person will support the weight of the shelf and move it to the 
desired height. If you turn the lever without supporting the weight of the shelf, the shelf 
will drop, possibly causing pinch or crush injuries.
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4 Move the keyboard shelf to the desired height. 

5 Turn the height- adjustment lever clockwise to tighten the collar and lock 
the shelf in position.

Adjusting the monitor tilt angle

To adjust the computer monitor tilt angle:

1 Using the supplied 3- mm hex wrench, loosen the screw on the back of the 
computer monitor.

2 Tilt the computer monitor to the desired angle.

3 Tighten the screw on the back of the computer monitor.

Related information

For information about... See...

BioCel System computer “Electronics cabinet” on page 7

Setup workflow “Setup Workflow” on page 24

Safety information BioCel System Safety Guide
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Starting up and shutting down the BioCel System

About this topic

This topic explains how to start up and shut down the BioCel System.

Before you start

Turning on the BioCel System initiates the startup process. Robots and devices 
might move during startup.

Before you turn on the system:

1 Make sure the main power line, air line, vacuum line (optional), and 
Ethernet cable are correctly connected. See the Automation Control Unit 
User Guide and the device user documentation for locations of the 
connections.

2 Make sure external drains and water lines are attached if your BioCel 
System uses them. Make sure the hoses are not kinked and that the hoses 
go through the appropriate pumps. See the site- specific documentation 
provided by Agilent Technologies. The site- specific documents address 
different system configurations and locations of drains and water lines. If 
you have questions, contact Automation Solutions Technical Support.

3 Make sure that any autofilling reservoirs are connected. See the Pump 
Module User Guide for instructions.

                                                        

WARNING  Access to and use of the interlock key should be controlled. To avoid 
possible injury, the Interlock BYPASS setting should be used only by personnel trained to 
teach the robots and devices in the system. The interlock key should be removed from the 
Automation Control Unit when the switch is set at NORMAL and you are not teaching 
robots and devices.

WARNING  Before starting up the system, make sure no one is inside the system, and 
then close all doors or remove objects that are disrupting the Light Curtain.

WARNING  Follow your organization’s lockout/tagout policy, if applicable. 
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Startup procedure

To start up the system:

1 At the Automation Control Unit, perform the following steps:

a Make sure the INTERLOCK key switch is set at NORMAL.

b Turn the power switch clockwise to the ON ( I ) position.

In systems where more than one Automation Control Unit is used, turn 
on all the units.

2 Turn on the UPS, if applicable. For instructions, see the UPS user 
documentation.

In systems where more than one UPS is used, turn on all the UPS units.

If the UPS emergency power- off (EPO) cable is installed, you must first 
reset the UPS EPO, and then turn on the UPS. For instructions, see the 
UPS user documentation.

If the system turns on successfully, you should hear the fan inside the 
Automation Control Unit turn on. After a few seconds, the indicator lights 
on the front of the Automation Control Unit turn on and show the current 
state of the system. The system status lights, if installed, also show the 
current system status. See “System status indicators” on page 14.

Note: If you have configured the air supply to turn on at startup, 
turning on the system also turns on the air supply. For information 
about configuring the air supply at startup, see the Automation Control 
Unit User Guide.

3 Verify that the red buttons on the emergency- stop pendants are released. 
(Turn the buttons clockwise to release them.)

4 Turn on the controlling computer.

5 Start the lab automation software. See the lab automation user 
documentation for instructions.

6 Turn on the integrated devices.

Note: Opening the doors or interrupting the Light Curtain to enter the 
system will trip the interlock. You will reset the system in a later step.

                                                        

NON-SWITCHED
AC

SWITCHED
AC

ACU POWER
5/24 VDC

DOORS

F15A, 600 VAC
CLASS CC

POWER

5 VDC 24 VDC
NORMAL BYPASS

INTERLOCK

RESET

DC STATUS

LIGHT
CURTAIN E-STOP

I   ON

O
   

O
FF

I   ON

O
   

O
FF



2   Setting up the BioCel System
Starting up and shutting down the BioCel System

30 BioCel System User Guide

7 If you use devices that require a vacuum created by a vacuum pump:

a Turn on the vacuum pump.

b Check that the gauge on the vacuum pump indicates a vacuum 
pressure.

8 If you use devices that require a non- air gas supply, make sure that the 
gas is turned on.

9 If the BioCel System has an incubator, turn on the incubator.

10 To reset the system:

a Make sure the system doors are closed and remove objects that are 
interrupting the Light Curtain.

b At the Automation Control Unit, press the blinking RESET button to 
reset the system. The blue RESET light turns solid.

Shutdown procedure

Shut down the BioCel System if you intend to:

• Leave it unused for a long period of time.

• Service the system.

• Move it to another location.

To shut down the BioCel System:

1 Make sure you have cleaned up after the last run. See “Cleaning up after 
every protocol run” on page 56 for cleanup instructions.

2 If you do not plan to use the controlling computer:

a Exit the lab automation software. See the lab automation software user 
documentation for instructions.

b Shut down the computer. Wait for Windows to exit.
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CAUTION To prevent the potential loss of data, always properly shut down and turn 
off the computer before shutting down the system.
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Notes:

• If the system has a UPS, the controlling computer is connected directly 
to the UPS without the UPS emergency power off (EPO) cable (default 
setup). Therefore, the computer will remain on after the system is shut 
down. However, if the UPS EPO cable is installed, turning off the 
Automation Control Unit will turn off the UPS and the computer.

• If the system does not have a UPS, the computer is connected directly 
to the Automation Control Unit. Turning off the system will 
automatically turn off the computer.

3 Turn off integrated devices.

4 If you use devices that require a vacuum pump, optionally turn off power 
at the pump if the pump has a power switch.

5 At the Automation Control Unit, turn the power switch counterclockwise to 
the OFF ( O ) position.

Note: Turning off the system also turns off the air supply.

6 Turn off the UPS, if applicable.

7 If you are moving the BioCel System, disconnect the air, vacuum, other 
gases, all communication cables, and all power cables.

Related information
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For information about... See...

Electrical requirements Site- specific documentation provided by 
Automation Solutions

Cleaning up after a protocol run “Routine maintenance” on page 56

Troubleshooting startup or 
shutdown problems

“Maintenance and troubleshooting” on 
page 55

Automation Control Unit and UPS 
configurations

Automation Control Unit User Guide
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Adding and deleting devices in the software

About this topic

The supplied controlling computer has the correct software configuration to 
communicate with the BioCel System and integrated devices. You do not need 
to create a new configuration or modify it unless you want to add or remove 
devices.

This topic explains how to add and delete the devices in the VWorks software. 
Read this topic if you are an administrator responsible for setting up and 
managing the BioCel System.

If you are using other lab automation software, see the user documentation for 
the software.

Devices and device file defined

A device is an item in your lab automation system that has an entry in the 
VWorks software device file. A device can be a robot, an instrument, or a 
location in the system that can hold a piece of labware. The following are some 
examples of devices:

• The robot in the BioCel System

• PlateLoc Sealer

• Microplate Labeler

• Vertical Pipetting Station shelf

• Platepad

• A third- party device integrated in the BioCel System

To communicate with and to control the robot and integrated devices, the 
VWorks software uses a device file that contains the following information:

• List of devices the software will communicate with and control

• Configuration information of each device (for example, approach height, 
allowed or prohibited labware, number of shelves, barcode access, and so 
on)

• The set of teachpoints to use (robots only)

You provide the device information in the VWorks software. The device 
information is stored in a device (.dev) file that is located in a folder you 
specify when saving the file.

For detailed information about device files and associations with profiles, 
teachpoint files, and labware definitions, see the VWorks Automation Control 
User Guide.

Creating a device file

If you are setting up the BioCel System for the first time, you need to create a 
new device file, and then add the BioCel System robot and integrated devices 
to this file.

Before you create a device file, start the VWorks software and log in. See the 
VWorks Automation Control User Guide for instructions.
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To create a new device file:

1 In the VWorks window, select File > New > Device. A Device File tab appears.

2 Select File > Save to save the device file. The file name appears in the 
Device File tab.

Adding a device 

To add a device to the device file:

1 In the Available Devices area, double- click the device that you want to add. 
Alternatively, you can drag a device from the Available Devices area into the 
Device File area.
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In the example shown, the Direct Drive Robot device is added. Notice that 
the first Direct Drive Robot device is labeled Direct Drive Robot- 1. If you 
add another Direct Drive Robot device, it will appear as Direct Drive 
Robot- 2.

If you do not see the device in the Available Devices list, check that the 
device plugin file is stored in the ...\Agilent Technologies\VWorks\Plugins 
folder. Also make sure you have the software license to use the plugin.

If you added a device plugin file in the Plugins folder and you have already 
started the VWorks software, be sure to reload the plugin. To do this, close 
any open device files and protocol files, and then select Tools > Reload 
Plugins.

2 In the device properties area, type a Name for the device.

In the following example, the name for the Direct Drive Robot is BioCel DD 
Robot.

3 If applicable, select the Profile.

If the profile you want does not appear in the list, or if no profile appears 
in the list, you need to create the profile, and then return to this step to 
select it. Without the profile, you will not be able to establish 
communication with the device.

To create a profile for the BioCel System robot, see one of the following:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide

To create a profile for an integrated device, see “Additional BioCel System 
Devices” on page 71, the Automation Solutions device user guide, or the 
third- party device driver user guide.

4 If applicable, set the device properties. See “Additional BioCel System 
Devices” on page 71, the Automation Solutions device user guide, or the 
third- party device driver user guide.

5 Select File > Save to save the device file.
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6 Repeat steps 1 through 5 to add other devices.

7 In the Device File area, click Initialize all devices to establish communication 
with the devices.

Deleting a device

To delete a device in the VWorks software:

1 In the VWorks window, select the device you want to delete in the Devices 
area.

2 Click Delete selected devices.

Disabling a device in a device file

You might want to temporarily disable a device when:

• Running a protocol using a subset of devices

• Running protocols that use different pipette heads or deck setup

• Performing maintenance on a non- pooled device

• Performing maintenance on a pooled device

The disabled device will be not be available during a protocol run. If the 
software encounters a task pointing to the disabled device during a run, the 
protocol will skip the task and continue the run. If the disabled device is part 
of a pool of devices and the other devices in the pool are available, the task 
will be executed using the available device.

Note: Up to 10 devices can be disabled in a single device file. 

Note: Disabled devices do not count towards the number of devices licensed.

The following devices cannot be disabled:

• All robots, for example the BenchBot Robot and Direct Drive Robot

• Automation Control Unit
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• BioCel I/O Interface

For instructions on how to disable a device, see the VWorks Automation 
Control User Guide.

Related information

For information about... See...

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

Setting the properties of a 
particular device

One of the following:

• Robot or device user documentation

• “Additional BioCel System Devices” 
on page 71

• Automation Solutions device user 
guide

• Third- party device driver guide

Creating a profile for a a system 
robot or a device

One of the following:

• Robot user documentation

• “Additional BioCel System Devices” 
on page 71

• Automation Solutions device user 
guide

• Third- party device driver guide

Setting teachpoints Robot user documentation
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3
Preparing for a protocol run

Before you start a protocol run, you should check the various 
devices in the BioCel System to ensure optimum operation.

This chapter contains the following topics:

• “Workflow for preparing a protocol run” on page 38

• “Performing dry runs” on page 39

• “Reviewing protocols and planning for the run” on page 40

• “Adding or removing devices mounted on docking tables” on 
page 41

• “Checking for system readiness” on page 50

• “Replacing the waste bin” on page 52

• “Loading labware in the system” on page 54
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Workflow for preparing a protocol run

Workflow

The workflow for preparing a protocol run is as follows:

Related information

Step For this task... See...

1 Review the protocol and plan 
for the run.

“Reviewing protocols and planning 
for the run” on page 40

2 Add devices that are mounted 
on docking tables.

“Adding or removing devices 
mounted on docking tables” on 
page 41

3 Check the system for 
readiness.

“Checking for system readiness” on 
page 50

4 Review the emergency stop 
and recovery procedure.

BioCel System Safety Guide

For information about... See...

Setting up the system “Setting up the BioCel System” on page 23

Protocols Lab automation software user 
documentation, such as the VWorks 
Automation Control User Guide
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Performing dry runs

What is a dry run?

A dry run is when you run a protocol using empty labware. A dry run allows 
you to troubleshoot a protocol or a component of the system without wasting 
valuable reagents and samples. You should always perform a dry run to check 
a new protocol.

Correcting teachpoint errors

After setting the teachpoints, be sure to perform a dry run as a final check for 
any teachpoint errors. The dry run also allows you to fine- tune orientation 
settings in systems that have the BenchBot Robot or the Direct Drive Robot.

Preparing for a dry run

You prepare for a dry run the same way you would prepare for a real protocol 
run. For the preparation workflow, see “Workflow for preparing a protocol run” 
on page 38.

Related information

For information about... See...

Writing protocols Lab automation software user 
documentation, such as the VWorks 
Automation Control User Guide

Preparing for a run “Workflow for preparing a protocol run” 
on page 38

Workflow for setting teachpoints One of the following:

• Robot or device user documentation

• “Additional BioCel System Devices” 
on page 71
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Reviewing protocols and planning for the run

Procedure

Before you start a run, make sure you review the protocol and determine:

• The devices used in the protocol and how to prepare them for operation. 
For example, you might need to load a roll of seal on the PlateLoc Sealer 
or install a pipette head on a Vertical Pipetting Station. See the device user 
guides for setup instructions.

• The optimal device setup sequence. In general, you first set up devices that 
do not hold time- sensitive reagents. Leave complex preparations, which 
might use expensive and unstable reagents, until last.

• The labware used in the protocol and where they should be positioned 
before the run starts. For example, you might have to load labware into 
one or more storage devices such as the Labware Stacker and the Plate 
Hub.

• The waste bins that should be emptied.

• The reservoirs that must be filled.

Be sure to check the protocol User Message tasks for setup information. If the 
User Message tasks prompt you to place counterweight labware, you do not 
have to include these steps in the setup.

Related information

For information about... See...

Creating or revising protocols Lab automation software user 
documentation, such as the VWorks 
Automation Control User Guide

Adding or removing devices that 
are on docking tables

“Adding or removing devices mounted on 
docking tables” on page 41

Checking the system for 
readiness

“Checking for system readiness” on 
page 50

Replacing the waste bin “Replacing the waste bin” on page 52

Troubleshooting the system “Loading labware in the system” on 
page 54

Stopping the protocol run in an 
emergency

BioCel System Safety Guide



41

3   Preparing for a protocol run
Adding or removing devices mounted on docking tables

BioCel System User Guide

Adding or removing devices mounted on docking tables

About this topic

Only trained BioCel System administrators should perform the procedures in 
this topic.

For a description of docking tables, see “Docking tables (optional)” on page 18.

Workflow for adding or removing devices mounted on docking tables

Adding devices mounted on docking tables
The workflow for adding devices that are mounted on docking tables is as 
follows:

Removing devices mounted on docking tables
The workflow for removing devices that are mounted on docking tables is as 
follows:

WARNING  Unlocking and removing protective windows, defeating interlocks and 
reconfiguring the system can expose you to serious hazards and may invalidate the safety 
compliance certification.

Step For this task... See...

1 Multiple docking- table systems 
only. Remove the protective 
window from the side of the 
system where the table will be 
docked.

“Removing and installing protective 
windows” on page 42

2 If applicable, connect the 
interlock cables to the E- STOP 
connectors on the system 
patch panel.

“Connecting to and disconnecting 
from the interlock system” on 
page 43

3 Dock the table. One of the following:

• “Docking and undocking the 
table automatically” on page 44

• “Docking and undocking the 
table with levers” on page 46

• “Docking and undocking the 
table with leveling casters” on 
page 48
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Removing and installing protective windows

In modular systems where multiple docking tables are interconnected, 
removable windows are installed on sides that permit the addition of docking 
tables. In these systems, you must first remove the protective window before 
docking a table, and install the protective window after undocking a table.

Removing the protective window on a docking table

To remove the protective window:

1 Windows without interlocks only. Using a 9- mm hex wrench, turn the two 
locks to unlock the window from the frame (1).

2 Windows with interlocks only. Turn the two black knobs on the window to 
unlatch the window from the frame (1).

3 While holding the handles (2), pull the bottom of the window outwards a 
few inches, then lift the window up until the window clamps are free from 
the top of the frame (3).

Step For this task... See...

1 Undock the table. One of the following:

• “Docking and undocking the 
table automatically” on page 44

• “Docking and undocking the 
table with levers” on page 46

• “Docking and undocking the 
table with leveling casters” on 
page 48

2 If applicable, disconnect the 
interlock cables from the E-
STOP connectors on the 
system patch panel.

“Connecting to and disconnecting 
from the interlock system” on 
page 43

3 Multiple docking- table systems 
only. Install the protective 
window on the side of the 
system that is exposed.

“Removing and installing protective 
windows” on page 42

2

1

3
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Installing the protective window

To install the protective window:

1 While holding the handles on the window, slide the window downward 
onto the front of the frame. Behind one of the frame posts are two screws. 
Make sure the corresponding window clamp fits between the two screws, 
as shown.

2 Windows with interlocks only. Turn the black knobs on the windows to 
secure the window latches.

3 Windows without interlocks only. Using a 9- mm hex wrench, turn the lock 
to secure the window latches. 

Connecting to and disconnecting from the interlock system

If devices or safety equipment on the docking table use the safety interlock 
system, you must connect them to the system interlock circuit when docking 
the table. When undocking the table, you must disconnect the devices or safety 
equipment from the interlock circuit.

IMPORTANT The safety interlock circuit must be closed for the system to 
operate. You can use the supplied jumper to close the circuit after 
disconnecting the devices.

Connecting to the interlock circuit

To connect the devices or safety equipment to the interlock circuit:

1 Remove the jumpers from the E-STOP or DOOR connectors on the system 
patch panel (below the system deck).

Note: The patch panel configuration can vary by system. Use the labels 
on the panel to identify the correct connectors for the devices and 
safety equipment.

00398
l i h i

00401
pathc panel

DOOR

E-STOP AIR

DEVICE 1 DEVICE 2 DEVICE 3

DEVICE 4 DEVICE 5 DEVICE 6



3   Preparing for a protocol run
Adding or removing devices mounted on docking tables

44 BioCel System User Guide

2 Connect the interlock cables from the devices or safety equipment to the E-
STOP or DOOR connectors on the system patch panel. Turn the connector 
clockwise until the connection is secure. 

Disconnecting from the interlock circuit

To disconnect the devices or windows from the interlock circuit:

1 Disconnect the device or safety equipment interlock cables from the E-STOP 
or DOOR connectors on the system patch panel. Turn the connectors 
counterclockwise to loosen and remove the connectors.

2 Install the supplied jumpers at the device E-STOP or DOOR connectors on 
the system patch panel.

Docking and undocking the table automatically

If the docking table is equipped with the QuickDock feature, the docking and 
undocking processes are automated.

To dock the table using the QuickDock feature:

1 Move the docking table so the red alignment tab on the docking table faces 
the two red alignment tabs on the BioCel System.

2 Push the table against the BioCel System, making sure the red alignment 
tab on the docking table fits between the two red alignment tabs on the 
BioCel System.
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3 Check the docking pendant. The pendant should display UNDOCKED and 
READY. If it does not, check the alignment of the table.

4 Press the pendant button. Lights on the pendant flash momentarily.

When the table is docked securely, the pendant displays READY and 
DOCKED.

5 Follow instructions in the robot user documentation to verify device 
teachpoints on the docking table.

To undock the table using the QuickDock feature:

1 Check the docking pendant. The pendant should display READY and 
DOCKED.
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2 Press the pendant button. Lights on the pendant flash momentarily.

When the table is undocked, the pendant displays UNDOCKED and READY.

3 Move the docking table away from the BioCel System.

Docking and undocking the table with levers

If the docking table is equipped with levers, the docking and undocking 
processes are performed manually.

Docking the table that has levers

To dock the table that has levers:

1 Move the docking table so the red alignment tab on the docking table faces 
the two red alignment tabs on the BioCel System.

2 Push the table against the BioCel System, making sure the red alignment 
tab on the docking table fits between the two red alignment tabs on the 
BioCel System.
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3 Under the docking table, firmly push up the two red levers until you hear 
them click. The click sound confirms that the table is docked.

4 Check that the table is securely docked. To do this, make sure the table 
does not move when you try to pull it away from the BioCel System.

5 Follow instructions in the robot user documentation to verify the 
teachpoints of the devices on the docking table.
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Undocking the table that has levers

To manually undock the table that has levers:

1 Under the docking table, firmly push down the red levers.

2 Move the docking table away from the BioCel System.

Docking and undocking the table with leveling casters

If the docking table is equipped with leveling casters, the docking and 
undocking processes are performed manually.

Docking a table with leveling casters

To dock a table with leveling casters:

1 Position the docking table adjacent to the system.

2 Turn the red wheel counterclockwise to extend the foot at each caster. 
Make sure the table is level.

3 Follow instructions in the robot user documentation to verify the 
teachpoints of the devices on the docking table:
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Undocking a table with leveling casters

To undock a table with leveling casters:

1 Turn the red wheel clockwise to raise the foot at each caster before moving 
the table.

2 Move the table away from the system.

Related information

00402
leveling caster

For information about... See...

Docking tables “Docking tables (optional)” on page 18

Mounting devices on the docking 
table

Automation Solutions Technical Support

Devices that can be integrated in 
the BioCel System

“Device integration options” on page 20

Available devices “Additional BioCel System Devices” on 
page 71

System robot Robot user documentation
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Checking for system readiness

Procedure

To check that the BioCel System is ready for a protocol run:

1 Remove labware at robot- accessible locations, including:

• Platepads

• External device plate stages

• Third- party device areas that will accept labware from the BioCel 
System

2 Remove any obstacle in the robot’s pathways.

3 Make sure all devices are set up correctly and prepared for the run. For 
instructions, see the user documentation for the device.

4 Make sure all devices are turned on, and the vacuum is turned on.

For the devices that require compressed air, make sure the air pressure 
meets the operating requirements. For the BioCel System compressed air 
requirements, see the site- specific documentation provided by Automation 
Solutions. For other devices, see the user documentation for the device.

5 Replace the waste bin. See “Replacing the waste bin” on page 52.

6 Load labware. See “Loading labware in the system” on page 54.

7 Make sure the INTERLOCK key switch is set at NORMAL.

Related information

WARNING  Access to and use of the interlock key should be controlled. To avoid 
possible injury, the Interlock BYPASS setting should be used only by personnel trained 
to teach robots and devices in the system or workstation. The interlock key should be 
removed from the BioCel System when the switch is set at NORMAL and you are not 
teaching the robots and devices.
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For information about... See...

Creating protocols Lab automation software user guide, 
such as the VWorks Automation 
Control User Guide

Interlock key settings Automation Control Unit User Guide
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Starting, pausing, monitoring, and 
stopping protocol runs

Lab automation software user guide, 
such as the VWorks Automation 
Control User Guide

Stopping a run in an emergency BioCel System Safety Guide

For information about... See...
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Replacing the waste bin

About this topic

If the BioCel System has an optional waste bin, make sure you empty the bin 
before starting a protocol run. The waste bin can be free- standing or on a 
hanger. This section explains how to replace the waste bin on a hanger.

Removing the waste bin

To remove the waste bin from its hanger:

1 Open the cabinet door nearest the bin.

2 Hold the bin at the top- right corner with your right hand.

3 Lifting the front side of the bin upwards with your right hand, place your 
left hand underneath at the bottom- left corner.

4 Supporting the bin with both hands, lift it up and off the hanger.

5 Slide the bin out of the BioCel System.

6 Close the cabinet door.

Installing the waste bin

To replace the waste bin on its hanger:

1 Open the cabinet door nearest the bin.

2 Slide the empty bin into the BioCel System until it lies underneath the 
waste opening, with the side of the bin resting against the hanger.

3 Lifting the front side of the bin upwards with your right hand, place your 
left hand underneath at the bottom left corner.

4 Using both hands, lift the bin up, over the hanger, and down so the hanger 
supports the underside of the lip.

5 Close the cabinet door.
                                                        

WARNING  If the BioCel System has an automated trash door over the waste bin, use 
caution when removing or replacing the waste bin. If a protocol is running, the automated 
door for the waste opening might open or close at any time. Do not attempt to retrieve or 
place the waste bin during a protocol run.
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Related information

For information about... See...

BioCel System air source 
requirements

BioCel System Site Preparation Guide

External device air source 
requirements

External device user documentation

Diagnosing air pressure problems “Troubleshooting hardware problems” 
on page 64
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Loading labware in the system

When you need to manually load labware in the system

Depending on the protocol, you might need to manually place microplates, tip 
boxes, reservoirs, or counterweights onto platepads, hotel shelves, device 
shelves, or labware storage devices before starting the run. For example, you 
generally need to load labware into Labware Stackers or one or more cassettes 
(racks) in the Plate Hub.

How you load the labware in various devices depends on the type of robot in 
the system and the device. This topic provides the following:

• “BenchBot Robot and Direct Drive Robot guidelines” on page 54

• “Plate Hotel, Plate Hub, and Labware MiniHub guidelines” on page 54

Note: If you need to add or replace the labware during the run, be sure to 
follow the same guidelines.

BenchBot Robot and Direct Drive Robot guidelines

Before loading labware in storage devices, always review the teachpoint file for 
labware orientation information. The labware must be loaded in the same 
orientation as specified in the teachpoint file.

Plate Hotel, Plate Hub, and Labware MiniHub guidelines

Before you start
Before loading labware in the Plate Hotel, Plate Hub, and Labware MiniHub, 
make sure the racks and slots used in the protocol are configured in the lab 
automation software. For detailed instructions, see “Plate Hotel” on page 111, 
“Plate Hub Carousel” on page 118, and the Labware MiniHub User Guide.

Review the “BenchBot Robot and Direct Drive Robot guidelines” on page 54 so 
that you know how the labware should be loaded.

Related information

For information about... See...

Plate Hotel and Plate Hub “Plate Hub Carousel” on page 118

Labware MiniHub Labware MiniHub User Guide

BenchBot Robot teachpoints BenchBot Robot User Guide

Direct Drive Robot teachpoints Direct Drive Robot User Guide

3- Axis Robot or Peak KiNEDx 
Robot

BioCel System User Guide, Revision 01, 
August 2010
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Maintenance and troubleshooting

This chapter explains how to maintain the BioCel System and 
provides troubleshooting information.

This chapter contains the following topics:

• “Routine maintenance” on page 56

• “Recovering from a power outage” on page 60

• “Recovering from servo errors” on page 61

• “Troubleshooting plate- sensor errors” on page 63

• “Troubleshooting hardware problems” on page 64

• “Reporting problems” on page 69

For software error messages, see the Automation Control Unit, 
robot, device, or lab automation software user documentation.

For emergency- stop recovery procedures, see BioCel System Safety 
Guide.
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Routine maintenance

About this topic

This topic provides recommendations for maintaining the BioCel System:

• Cleaning up after every protocol run

• Cleaning up spills in the liquid cabinet

• Monthly inspection and maintenance

For the maintenance of integrated devices, see the user documentation for the 
devices.

Cleaning up after every protocol run

In general, practice good housekeeping by cleaning up spills and following the 
post- run clean- up procedures.

To clean up after a run:

1 Follow the lab automation software prompts for post- run procedures, such 
as unloading the labware. See the lab automation software user 
documentation, such as VWorks Automation Control User Guide, for 
detailed instructions.

2 Unload used labware from the devices.

3 Remove manually placed labware from devices.

4 See the device user documentation for cleanup instructions.

5 Clean up spills, if any. If you have a liquid cabinet, see “Cleaning up spills 
in the liquid cabinet” on page 56.

6 Check run logs for errors.

7 If you have administrator or technician privileges and you have modified 
the protocol, including selected options, you can save the protocol.

8 Log out of the software. See the lab automation software user 
documentation, such as VWorks Automation Control User Guide, for 
instructions.

Cleaning up spills in the liquid cabinet

If your system has a liquid cabinet, you should check for and clean up any 
spills in the cabinet after every run.

To clean up spills in the liquid cabinet:

1 At the liquid cabinet:
                                                        

WARNING  Follow your laboratory, local, state, and federal safety regulations when 
disposing of chemicals.
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a Turn the two knobs clockwise to unlatch the door.

b Open the door.

2 Disconnect the tubes and remove the Pump Module, liquid containers, or 
other equipment from the shelves.

3 Push the shelves inward to unlock the shelves (1), and then slide the 
shelves outward (2).

To facilitate cleaning, you can remove the shelves from the cabinet. To 
remove a shelf from the cabinet, while pressing the black tabs on both 
sides of the shelf, pull the shelf all the way out.

                                                        

1
2
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4 Lift and remove the mesh insert.

5 Clean and wipe dry the shelf tray and the mesh insert. 

You can also clean the spill gutter at the lower back wall of the cabinet. If 
you do this, take care to clean around the spill- detection sensor at the 
bottom right side of the gutter.

6 Place the clean mesh insert on top of the shelf.

7 If the shelves were removed from the cabinet, insert the shelves back into 
the cabinet. Make sure the shelf is inserted correctly between the guide 
rails.

8 Slide the shelves in, and then push them against the back of the cabinet 
until they are locked into position.

9 Place the Pump Module, liquid containers, or other equipment back onto 
the shelves and reconnect the tubes.

10 Close the door, and then turn the two knobs counterclockwise to lock the 
door.
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Monthly inspection and maintenance

Once a month, check the following:

• Robot gripper pads are not torn, cracked or otherwise worn. To replace the 
robot gripper pads, see the robot user documentation or contact 
Automation Solutions Technical Support.

• Liquid- handling tubing is not torn, cracked or discolored. See the liquid-
handling device user documentation for detailed instructions. 

• Table top is free of debris, such as pieces of chipped microplates and 
microtubes.

Related information

For information about... See...

Shutdown procedure  “Shutdown procedure” on page 30

Safety BioCel System Safety Guide

Reporting problems “Reporting problems” on page 69
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Recovering from a power outage

About this topic

This topic explains how to recover the BioCel System from a power outage.

During the power outage

During a power outage, if the BioCel System has a UPS, the following occurs:

• The UPS starts to beep while providing power to the devices. 

• If you have specified email notification during setup, the lab automation 
software writes an error message to the log, displays an error message on 
the screen, and notifies you.

• If the system is running a protocol, it will continue until the UPS charge 
passes the thresholds specified in lab automation software. When the 
threshold is reached, the lab automation software exits and the computer 
shuts down automatically.

If the BioCel System does not have a UPS, the system stops during a power 
outage. If the system is running a protocol, the run stops.

Recommended actions during a power outage (systems with UPS only)

If a running protocol is nearly finished, you might consider letting it continue 
until it is finished.

If you started running a protocol and you anticipate a lengthy power outage, 
you might consider stopping the run.

When the power is restored

If the BioCel System was not shut down during the power outage, the system 
will receive power, the UPS recharges, and the protocol (if running) continues.

If the BioCel System does not have a UPS and the running protocol was 
stopped, you need to restore the system and rerun the protocol. Follow the 
instructions in the BioCel System Safety Guide to restore the system.

Related information

For information about... See...

Setting the VWorks software UPS 
threshold

VWorks Automation Control User 
Guide

Turning on the BioCel System “Starting up and shutting down the 
BioCel System” on page 28

Safety BioCel System Safety Guide

Reporting problems “Reporting problems” on page 69
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Recovering from servo errors

About this topic

This topic explains how to recover from servo errors.

Causes of servo errors

A servo system controls the robot’s motions. The servo cuts power to the robot 
if it encounters resistance to movement that is slightly higher than that 
expected from the inertia of the robotic arm holding a labware. When the 
power is cut, a servo error is generated.

Most servo errors occur when the labware being carried crashes into another 
labware that is on a device. 

Procedure

To recover from a servo error:

1 Check the BioCel System table to determine the cause of the collision and 
remove the obstruction. For example, it might be a labware from a previous 
run.

2 Check the labware that is held by the robot to make sure it is not damaged 
and that its contents are not spilled.

3 Make sure the labware did not move in the robot gripper during the 
collision.

4 If the labware has not moved in the robot gripper and was not damaged 
during the collision, in the error message dialog box, click one of the 
following:

                                                        

Selection Description

Diagnostics Opens the device diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Retry Attempts to restart the current command or task in 
the run.

Ignore and 
continue

Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Abort Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.
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5 If the labware has moved during the collision or was damaged, in the error 
message dialog box, click Diagnostics and move the labware manually:

a Move the robot to a position that is easy for you to access.

b While holding the labware with your hand, in the diagnostics software, 
use the available software command to open the robot grippers. The 
robot releases the labware. For diagnostics software instructions, see 
the robot user documentation.

c Place the labware at the destination location manually.

d Close the robot diagnostics software.

e Click in the next error message dialog box, click Ignore and continue.

6 If the crash was severe, home the robot. To do this, in the robot 
diagnostics software, use the available command to home the robot. For 
diagnostics software instructions, see the robot user documentation.

Related information

For information about... See...

Emergency stop circuits “Power system” on page 148

Automation Control Unit “Electronics cabinet” on page 7

Verifying teachpoints Robot user documentation

Reporting problems “Reporting problems” on page 69
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Troubleshooting plate-sensor errors

About this topic

This topic explains how to troubleshoot plate- sensor errors in systems that 
have the 3- Axis Robot.

Procedure

To troubleshoot a plate-sensor error:

1 If the robot is not holding labware in the gripper, determine whether the 
labware was:

• Knocked out of the gripper. In this case, find out what knocked the 
labware out of the gripper.

• Missing from the location at which the robot attempted to pick it up. 
In this case, place the correct labware in the location and click Retry in 
the Robot Error dialog box.

• Not picked up. In this case, there might be a problem with either the 
labware definition for the labware or a teachpoint. Check the labware 
definition. Check the teachpoint at the position where it failed to pick 
up the labware, and the teachpoint at the previous position. If there 
does not seem to be a teachpoint error, contact Automation Solutions 
Technical Support.

2 If the labware is held in the gripper but is not seated correctly, establish 
whether the labware was positioned correctly at the pickup location.

• If the labware was not positioned correctly at the pickup location, 
reposition the labware and click Retry in the Robot Error dialog box.

• If the labware was positioned correctly at the pickup location, there 
might be a problem with the approach or departure height. 
Alternatively, there might be a problem with the labware, the labware 
definition, a teachpoint, or the plate sensor. In this case, you should 
contact Automation Solutions Technical Support.

Related information

For information about... See...

Emergency stop circuits “Power system” on page 148

Verifying teachpoints Robot user documentation

Reporting problems “Reporting problems” on page 69
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Troubleshooting hardware problems

About this topic

This topic lists possible system- level hardware problems, the causes of the 
problems, and ways to resolve the problems. If the problem persists, contact 
Automation Solutions Technical Support.

For problems that are specific to the Automation Control Unit, robot, or a 
device, see the associated user documentation.

This topic describes the following:

• “Power and communication” on page 64

• “Air supply” on page 65

• “Protocol runs” on page 65

• “Robot and labware” on page 66

• “Delidding devices” on page 67

Power and communication

Problem Cause Solution

The system does not 
turn on.

The BioCel System is not 
connected to the power source.

Check the BioCel System power 
connections.

The power supply circuit breaker 
switches have been tripped.

Reset the circuit breakers.

The UPS is not turned on or is not 
working properly.

Turn on the UPS. See “Starting up 
and shutting down the BioCel 
System” on page 28.

A power fuse in the Automation 
Control Unit is blown.

Replace the spent fuse. See the 
Automation Control Unit User 
Guide for instructions.

The integrated devices 
do not turn on.

The Automation Control Unit is not 
connected to the power source.

Connect the Automation Control Unit 
to the power source.

The devices are not connected to 
the Automation Control Unit.

Make sure the devices are connected 
correctly and securely to the 
Automation Control Unit. For 
connection instructions, see the 
Automation Control Unit User 
Guide.

An integrated device 
is turned on, but it 
does not operate.

The device has not been initialized. Initialize the device in the lab 
automation software. See the device 
and software user documentation for 
instructions.
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Air supply

Protocol runs

Problem Cause Solution

A hissing sound is 
audible.

A leak is present in the air 
connection or inside the system.

Turn off the power at the 
Automation Control Unit (“Starting 
up and shutting down the BioCel 
System” on page 28). Turning off the 
power also turns off the air supply.

Check the air connections at the air 
distribution panel and at the source 
(house, cylinder, or pump). 

Check the connections to individual 
devices and any junctions.

If the connections look fine, the leak 
might be inside the system. Contact 
Automation Solutions Technical 
Support.

Oil is present inside 
devices or the system.

The compressed air is not from an 
oil- free compressor and oil has 
leaked into the system.

Contact Automation Solutions 
Technical Support.

Problem Cause Solution

Unable to start 
protocol runs.

An obstacle is preventing the 
system door from closing or is 
interrupting the Light Curtain.

Remove any obstacle that is in the 
system doorway or is interrupting 
the Light Curtain.

Unable to resume runs 
after a pause.

An obstacle is preventing the 
system door from closing or is 
interrupting the Light Curtain.

Remove any obstacle that is in the 
system doorway or is interrupting 
the Light Curtain.

The blue light on the RESET 
button is blinking and has not 
been pressed.

Press the RESET button on the 
Automation Control Unit.

The robot and many 
devices are moving too 
slowly during runs.

The INTERLOCK key switch is set 
at BYPASS.

If you are not teaching the robots or 
diagnosing system problems, set the 
INTERLOCK key switch at NORMAL.

The system does not 
pause when the door 
is opened or when the 
Light Curtain is 
interrupted.

The INTERLOCK key switch is set 
at BYPASS.

If you are not teaching the robots or 
diagnosing system problems, set the 
INTERLOCK key switch at NORMAL.
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Robot and labware

Note: This topic presents system- level problems and solutions. For additional 
troubleshooting information, see the BenchBot Robot User Guide and the 
Direct Drive Robot User Guide.

Problem Cause Solution

Labware drops or is 
held loosely by the 
robot.

• The labware definition for the 
microplate type might contain 
incorrect information.

• The Grip torque parameter 
value is incorrect for the 
labware.

• The Gripper offset range in 
incorrect.

• The robot gripper pads are 
dirty.

• The grippers are damaged.

• Check the labware definition for 
errors.

• In Labware Editor, change the 
Grip torque value for the 
labware.

• In the Labware Editor and the 
DDR Diagnostics, change the 
Gripper Offset Range values.

• Clean the robot gripper pads.

• Call Automation Solutions 
Technical Support to replace the 
damaged robot grippers.

Labware bends when 
held by the robot.

The Grip torque parameter value is 
incorrect for the labware.

In Labware Editor, change the Grip 
torque value for the labware.

The robot is not 
moving to and from 
the teachpoints 
accurately.

The robot axes need to be 
recalibrated.

Home the robot. See the robot user 
documentation:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide

The teachpoint coordinates or 
orientations are inaccurate. The 
approach height value might be 
incorrect.

Verify and edit the teachpoint. See 
the robot user documentation:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide

The robot is unable to 
place labware at the 
target location 
accurately.

• The target location teachpoint 
is incorrect.

• The teachpoint of the 
previously scheduled device is 
incorrect.

• The target device was moved or 
reconfigured and the 
teachpoint was not updated.

• Approach height setting is 
incorrect.

• The labware might be damaged 
or deformed.

• The robot gripper pads are 
dirty.

• The robot gripper pads are 
worn unevenly or are damaged.

• Incorrect gripper offset range 
is specified.

• Verify and edit the teachpoints.

• Check the approach height 
setting.

• Clean the robot gripper pads.

• Replace the damaged or 
deformed labware.

• Check and correct the gripper 
offset ranges for the labware, the 
pick location, and the place 
location. 

See the robot user documentation:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide
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Delidding devices

The robot placed the 
labware such that the 
A1 well is in the 
wrong orientation.

The incorrect A1- well orientation 
is specified for the teachpoint.

In the teachpoint file, verify the A1-
well orientation specification. Change 
the specification if necessary. See 
one of the following:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide

The robot collides 
with devices or 
obstacles when moving 
from teachpoint to 
teachpoint.

The incorrect robot- arm 
orientation, approach height, or 
approach distance values are used.

In the teachpoint file, check and 
correct the robot- arm orientation, 
approach height value, and approach 
distance value. See one of the 
following:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide

Problem Cause Solution

Problem Cause Solution

The Lid Hotel Station 
is not delidding or 
relidding properly.

• The rollers in the Lid Hotel 
Station are dirty.

• The robot is holding the 
labware at the lid instead of 
below at the microplate.

• Barcode labels are applied to 
the lid and the labware, 
preventing the lid from being 
removed.

• Too many layers of barcode 
labels are applied to the 
labware.

• The lids have sticky residues 
from the barcode labels.

• Clean the rollers in the Lid Hotel 
Station.

• Check and adjust the robot 
gripper offset for the labware.

• Check how the barcode labels 
are applied to the labware. Make 
sure the labels are applied 
correctly.

• Remove excess layers of old 
barcode labels before applying 
new labels.

• Clean the barcode label residues 
from the labware lids.
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Related information

The Vacuum Delid 
Station is not working 
properly.

Air flow to the Vacuum Delid 
Station is insufficient.

• Check the air pressure and 
connections at the utilities panel 
and at the source (house, 
cylinder, or pump).

• Check for leaks in the air supply 
line.

Holes in the black rubber suction 
cups are causing vacuum leaks.

Contact Automation Solutions 
Technical Support to replace the 
black rubber suction cups.

The Vacuum Delid Station 
teachpoint is incorrect.

Check and correct the teachpoint. 
Make sure you check the approach 
height value.

Check the approach distance value. 
Also, check the selected custom 
action (Direct Drive Robot) or 
teachpoint type (BenchBot Robot). 
See one of the following:

• BenchBot Robot User Guide

• Direct Drive Robot User Guide

Problem Cause Solution

For information about... See...

BioCel System component names “Hardware overview” on page 5

Software error messages Robot or device user documentation

Diagnosing problems Robot or device user documentation

3- Axis Robot BioCel System User Guide, Revision 01, 
August 2010

Peak KiNEDx Robot BioCel System User Guide, Revision 01, 
August 2010

Staubli Robot Staubli TX60 Device Driver User Guide

Reporting problems “Reporting problems” on page 69

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf


69

4   Maintenance and troubleshooting
Reporting problems

BioCel System User Guide

Reporting problems

Contacting Automation Solutions Technical Support 

Note: If you find a problem with the BioCel System, contact Automation 
Solutions Technical Support. For contact information, see Notices on the back 
of the title page. 

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the individual device ready. Do not use the system serial number.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box

• Relevant software files

To find the VWorks software version number:

In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:
In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

• Plate map files

• Barcode files

• Error library

• Log files

• Form file (*.VWForm)
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Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
Related information

For information about... See...

Hardware problems “Troubleshooting hardware problems” 
on page 64

Software error messages Robot or device user documentation

Recovering from emergency stops BioCel System Safety Guide

Recovering from power outage “Recovering from a power outage” on 
page 60

Recovering from servo errors “Recovering from servo errors” on 
page 61

Troubleshooting plate- sensor error “Troubleshooting plate- sensor errors” 
on page 63

Safety BioCel System Safety Guide

mailto:documentation.automation@agilent.com
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Additional BioCel System Devices

This chapter describes the additional devices available for 
integration in the BioCel System and provides installation and 
configuration instructions. This chapter contains the following 
topics:

• “BioCel System additional devices overview” on page 72

• “Auxiliary barcode reader” on page 74

• “Lid Hotel Station” on page 81

• “Linear Translator” on page 88

• “Orbital Shaking Station” on page 101

• “Phantom Robot” on page 107

• “Plate Hotel” on page 111

• “Plate Hub Carousel” on page 118

• “Platepad” on page 131

• “Vacuum Delid Station” on page 134

• “Waste bin” on page 138

• “Weigh Pad” on page 141
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BioCel System additional devices overview 

About this topic

This topic lists and briefly describes additional devices available for integration 
in the BioCel System. For the latest list of devices available, contact 
Automation Solutions Technical Support.

Additional devices list

In addition to the devices that are listed in “Device integration options” on 
page 20, you can install and configure one or more of the following 
Automation Solutions devices in the BioCel System.

Device Description See...

Automation Control 
Unit

Distributes AC and DC power to system 
components, provides compliant safety features, 
receives and transmits signals from and to 
system components.

Automation Control Unit 
User Guide

Auxiliary barcode 
reader

Scans barcodes on labware. “Auxiliary barcode reader” 
on page 74

Device stacking 
shelves

Allows the stacking of devices to maximize the 
use of space.

Automation Solutions 
Technical Support

Labware MiniHub Stores microplates and tip boxes. The device is 
more compact than the Plate Hub.

Labware MiniHub User 
Guide

Labware Stacker Stores deep- well and shallow- well microplates, 
pin tools, tip boxes, and lids. Dispenses and 
receives the labware from robots.

Labware Stacker User 
Guide

Lid Hotel Station Removes and stores microplate lids. “Lid Hotel Station” on 
page 81

Linear Translator Transports microplates, one at a time, from a 
device (or robot) to a device (or robot). The 
device has a fixed- length body with a motorized 
plate stage that moves from one end to another.

“Linear Translator” on 
page 88

Microplate 
Exchanger

Passes microplates between two system robots. Microplate Exchanger 
User Guide

Orbital Shaking 
Station

Shakes labware for a specified length of time. “Orbital Shaking Station” 
on page 101

Phantom Robot Permits the manual movement of labware during 
a protocol run.

“Phantom Robot” on 
page 107

Plate Hotel Stores microplates. “Plate Hotel” on page 111

Plate Hub Carousel, 
Landscape or 
Portrait

Stores microplates and tip boxes. “Plate Hub Carousel” on 
page 118
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Related information

Platepad Holds a single microplate. “Platepad” on page 131

Vacuum Delid 
Station 

Removes microplate or tip box lids using 
vacuum.

“Vacuum Delid Station” on 
page 134

Waste bin Receives microplate lids, used pipette tips, or 
other trash.

“Waste bin” on page 138

Weigh Pad Monitors and maintains the percentage of liquid 
in a container that is on the Weigh Pad.

“Weigh Pad” on page 141

Device Description See...

For information about... See...

Using the device in a protocol VWorks Automation Control User 
Guide

BioCel System setup workflow “Setup Workflow” on page 24

BioCel I/O Interface BioCel System User Guide, Revision 01, 
August 2010

Microplate Conveyor BioCel System User Guide, Revision 01, 
August 2010

Microplate Shuttle and Rotator BioCel System User Guide, Revision 01, 
August 2010

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Auxiliary barcode reader 

About this topic

This topic describes the auxiliary barcode reader, explains its use, and 
provides the setup instructions.

Description

The auxiliary barcode reader is either attached to a platepad or a device. 
Depending on the setup, the barcode reader scans barcodes on one of four 
sides of microplates. The following figure shows an example barcode reader 
that is attached to a platepad and is oriented to scan barcodes on the east and 
west sides of microplates.

Setup workflow 

Step Procedure See...

1 Install the barcode reader. Automation Solutions 
Technical Support

2 Add the barcode reader in the 
device file.

“Adding the barcode reader 
in the device file” on page 75

3 Add the platepad or device to 
which the barcode reader is 
attached.

“Adding the platepad or 
device” on page 75

4 Create a profile for the barcode 
reader.

“Creating a profile for the 
barcode reader” on page 77

5 Set and edit the teachpoint for the 
barcode reader platepad or device.

Robot user documentation

6 Test the barcode reader. “Testing the barcode reader” 
on page 78
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Adding the barcode reader in the device file

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new barcode 
reader to the device file unless you are adding another barcode reader or 
replacing the existing barcode reader. For information about device files, see 
“Devices and device file defined” on page 32.

To add the barcode reader to the device file:

1 In the VWorks software, open the device file and add the Keyence Barcode 
Reader. See “Adding and deleting devices in the software” on page 32 for 
instructions.

2 In the Keyence Barcode Reader Properties area, type or select the following:

3 Select File > Save.

Adding the platepad or device

After adding the barcode reader in the device file, you must add the platepad 
or device to which the barcode reader is attached. In addition, you specify the 
barcode reader in the platepad or device properties.

Property Description

Name The name of the barcode reader device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the barcode reader” on 
page 77, and then return to this step to 
select the profile.
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To add the platepad or device in the device file:

1 In the device file, add the Plate Pad or the desired device. See “Platepad” 
on page 131 or “Adding and deleting devices in the software” on page 32 
for instructions.

2 In the Devices area, expand the Plate Pad or device, and then select the 
Stage to which the barcode reader is attached.

3 In the PlatePad Stage Location Properties or device stage properties area, type 
or set the parameters. See “Platepad” on page 131 or the device guide for 
detailed instructions. Make sure you specify the location of the barcode 
reader on the platepad or device. 

4 Select File > Save.
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Creating a profile for the barcode reader

The barcode reader profile allows you to set up communication between the 
barcode reader and the controlling computer.

To create a profile for the barcode reader:

1 In the VWorks window, select the Keyence Barcode Reader device, and then 
click Device diagnostics. 

The Keyence Barcode Reader Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.

5 In the Profile Settings area, select the COM port number used by the barcode 
reader.

6 Click Update this profile to save the changes.
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7 Click Initialize this profile to establish communication with the barcode 
reader.

8 Return to the device file and select the profile for the barcode reader 
device.

Testing the barcode reader

Barcode label specifications
The barcodes must meet the following requirements:

IMPORTANT Although the barcode reader supports all of the formats listed in 
the table, its setup is limited to four formats. Use the barcode reader utility 
program to select the four desired barcode formats. See the barcode reader 
user documentation for instructions.

Before you start
Make sure you have the following:

• M2 hex wrench

• Spare microplate that has a barcode label

Test procedure

To test the barcode reader:

1 Place the spare microplate on the Barcode Reader location and make sure 
the barcode label faces the Barcode Reader mirror.

2 Open Keyence Barcode Reader Diagnostics.

Characteristic Requirement

Barcode formats Code 39 
Codabar 
Code 128 
Interleaved 2 of 5 
Code 93 
UPC/EAN 
Pharmacode 
PDF417

Barcode height 3.34 mm (0.13 in) or taller

Print contrast 25% at 650 nm

Quiet zone 10 times the dimension of the 
narrowest element in the barcode 
or 6.35 mm (0.25 in), whichever is 
greater

WARNING  The barcode reader sensor head contains a class II laser that emits light at 
650 nm, producing up to 1.5 mW of energy. Do not look directly into the laser beam. Looking 
directly into the laser beam or looking at the reflected beam can cause eye injury.

WARNING  Do not disassemble the barcode reader sensor head. Laser emission does 
not automatically turn off if the sensor head is disassembled.
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3 In the Profiles tab, select the Barcode Reader profile from the Profile list, 
and click Initialize this profile.

4 Click the Controls tab.

5 Click Scan barcode. The barcode reader laser turns on briefly to scan the 
barcode label. One of the following messages appears next to Scan result:

                                                        

Scan result message Description Next step

<barcode text> The barcode was 
successfully scanned.

The setup is 
complete. No further 
adjustment is 
required.

No barcode found Barcode scanning was not 
successful.

Proceed to step 6.
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6 If the No barcode found message appears, click Scan barcode again and 
check that the barcode reader laser beam is projected onto the vertical 
center of the barcode label.

If the laser beam is not at the vertical center of the label, adjust the scan 
angle of the barcode reader.

Adjusting the scan angle
Depending on the setup, the angle adjustment process can differ. If the barcode 
reader is attached to a platepad, you can loosen the screws on both sides of 
the reader to change the scan angle. If the barcode reader is mounted on the 
side of a device, you might have to loosen the screws on the mounting plate to 
change the scan angle. If you need assistance with the process, contact 
Automation Solutions Technical Support.

Troubleshooting
If the reader is unable to scan the barcode after many adjustments, try one or 
more of the following:

• Make sure the barcode label is applied properly onto the microplate.

• Make sure the microplate is sitting level at the Barcode Reader location.

• Make sure the barcode and label meet the format requirements. See 
“Barcode label specifications” on page 78.

• Repeat the adjustment process using a new spare microplate.

Related information

For information about... See...

Set the teachpoint for the barcode 
reader platepad or device

Robot user documentation

Using the barcode reader in a 
protocol

VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 72
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Lid Hotel Station 

About this topic

This topic describes the Lid Hotel Station, explains its use, and provides the 
configuration instructions.

Description

The Lid Hotel Station1 is a vertical rack that holds microplate lids while the 
microplates are processed. Rollers at each storage bay (or slot) hold onto a lid 
while the robot moves the microplate downward to remove the lid. When the 
microplate returns to the storage bay, the robot moves the microplate upward 
for relidding, and then pulls the lidded microplate out of the bay.

1 Concept developed by Novartis Pharma AG, NIBR/DT/IAT, Basel, Switzerland.

Setup workflow

00087
plate hotel
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Step Procedure See...

1 Install the Lid Hotel Station. Automation Solutions 
Technical Support

2 Add the Lid Hotel Station in the 
device file.

“Adding the Lid Hotel Station 
in the device file” on page 82

3 Create a profile for the Lid Hotel 
Station.

“Creating a profile for the Lid 
Hotel Station” on page 83

4 Set, edit, and verify the teachpoint 
for each storage bay (slot).

“Setting storage bay 
teachpoints” on page 85
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Adding the Lid Hotel Station in the device file 

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new Lid 
Hotel Station to the device file unless you are adding another Lid Hotel Station 
or replacing the existing Lid Hotel Station. For information about device files, 
see “Devices and device file defined” on page 32.

Note: After adding the Lid Hotel Station, you must add each storage bay (slot) 
as a device to the device file.

To add the Lid Hotel Station to the device file:

1 In the VWorks software, open the device file and add the Lid Hotel Station. 
See “Adding and deleting devices in the software” on page 32 for 
instructions.

2 In the Lid Hotel Station Properties area, type or select the following:

3 In the Devices area, expand Lid Hotel Station, and then select a storage bay 
(slot) number.

                                                        

Property Description

Name The name of the Lid Hotel Station device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Lid Hotel Station” on 
page 83, and then return to this step to 
select the profile.



83

A   Additional BioCel System Devices
Lid Hotel Station

BioCel System User Guide

4 In the Lid Hotel Station Properties area, type or set the following:

5 Select File > Save.

Creating a profile for the Lid Hotel Station 

The Lid Hotel Station profile allows you to set up communication between the 
Lid Hotel Station and the controlling computer. You can also indicate the 
number of hotel slots that will be used.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. This selection enables the robot to 
move correctly to and from the storage bay 
(slot) during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the Lid 
Hotel Station.
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To create a profile:

1 In the VWorks software, open Lid Hotel Station Diagnostics.
U

2 The Lid Hotel Station Diagnostics dialog box opens.

3 Click the Profiles tab.

4 Click Create. The New Profile dialog box opens.

5 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Control area.
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6 In the Parameters area:

• In the COM Port list, select the serial port that connects the Lid Hotel 
Station to the controlling computer.

• In the Number of slots box, type the number of storage bays (slots) you 
want to use. By default, the software displays the maximum number of 
slots: 10. However, if you only want to use the slots 1 through 5, type 
5.

• Always select Use reverse sensor logic. If an empty Lid Hotel Station 
sensor shows labware present in all slots, clear the Use reverse sensor 
logic check box.

7 Click Save settings.

Setting storage bay teachpoints

This section presents guidelines for setting Lid Hotel Station storage bay 
teachpoints. For detailed instructions on how to set a teachpoint, see the robot 
user documentation.

Direct Drive Robot guidelines

When you set the storage bay (slot) teachpoints:

1 Use the provided teaching jig to set a teachpoint at the top of the hotel. 
The platepad at the top of the hotel is similar to a standard platepad, so 
set the teachpoint as if it is a standard platepad. 

2 In DDR Diagnostics, copy the teachpoint you created in step 1 and rename it 
for Lid Hotel slot 10. (See the Direct Drive Robot User Guide for 
instructions on copying teachpoints.)

Make sure you:

• Set Approach Ht (with labware) and Approach Ht (no labware) at 0.

• For Pick Custom Action, select Lid Hotel relid.

• For Place Custom Action, select Lid Hotel delid.

• Edit Position Z for the new teachpoint by subtracting 22 mm from the 
current value.

3 In DDR Diagnostics, copy the slot 10 teachpoint, rename it for slot 9, and 
then edit Position Z by subtracting 40 mm from the current value. You do 
not need to edit the other teachpoint parameters.

4 Repeat step 3 to create teachpoints for the remaining slots.

5 Save the teachpoints.

6 Verify the teachpoints are set accurately. Make adjustments if necessary.

During the verification process, make sure:

• The lid does not readjust itself in the x- y plane as the robot moves the 
labware away from the lid. Readjusting movements indicate the 
teachpoint needs to be edited.

• The lid is centered between the rollers (1). When viewing the lid from 
the side, the rollers should be vertically centered (2).
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BenchBot Robot guidelines
To set teachpoints for the storage bays (slots) in the hotel, see the robot user 
documentation.

When you set the storage bay (slot) teachpoints:

1 Install the provided teaching plate in the robot grippers, and then enter 
the teach mode.

2 Use the provided teaching plate to set a teachpoint at the top of the Lid 
Hotel Station. The platepad at the top of the hotel is similar to a standard 
platepad, so set the teachpoint as if it is a standard platepad. 

3 Manually move the robot arm and position the teaching plate in the Lid 
Hotel Station slot 10 as follows:

• The bottom of the robot grippers should rest gently on top of the 
rollers.

• Make sure the teaching plate is centered between the rollers. Align the 
front edge of the teaching plate with back side of the Lid Hotel Station.

4 Set the teachpoint at slot 10.

When setting the teachpoint, make sure you:

• Select Lid Hotel from the Type list.

• Set Approach Ht at 0.

5 Repeat steps 3 and 4 for the remaining slots.

6 Save the teachpoints.

7 Verify the teachpoints are set accurately. Make adjustments if necessary.

During the verification process, make sure:

• The lid does not readjust itself in the x- y plane as the robot moves the 
labware away from the lid. Readjusting movements indicate the 
teachpoint needs to be edited.

• The lid is centered between the rollers (1). When viewing the lid from 
the side, the rollers should be vertically centered (2).

1 2

1 2
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Monitoring the hotel-slot status 

Sensors at each hotel storage bay (slot) detect the presence of a lid, and the 
software displays the status in Lid Hotel Diagnostics.

To view the hotel storage bay (slot) status:

In Lid Hotel Diagnostics, click the Controls tab. The list of storage bays (slots) and 
corresponding indicator lights are displayed in the Plates Present area. If a bay 
(slot) is occupied, the corresponding light turns on.

Related information

For information about... See...

Using the Lid Hotel Station in a 
protocol

VWorks Automation Control User 
Guide

Vacuum Delid Station “Vacuum Delid Station” on page 134

Available devices “BioCel System additional devices 
overview” on page 72
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Linear Translator 

About this topic

This topic describes the Linear Translator, explains its use, and provides the 
configuration instructions.

Description

The Linear Translator has a fixed- length body with motorized plate stage that 
transports a microplate in one of the following ways:

• Between two robots residing in adjacent BioCel Systems

• Between a BioCel System robot and an incubator that has its own robot

The translator has two axes that enable two types of movements:

• Transports microplates linearly along the mover.

• Rotates microplates in any orientation at both ends of the mover.

Enabling microplate rotation accommodates different device or robot- access 
requirements. For example, the incubator at one end of the translator might 
require landscape microplate- orientation while the robot at the opposite end of 
the mover might require the microplate to be at a specific angle.

Setup workflow
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Step Procedure See...

1 Install the Linear Translator. Automation Solutions 
Technical Support

2 Add the Linear Translator in the 
device file.

“Adding the Linear Translator 
to the device file” on page 89

3 Create a profile for the Linear 
Translator.

“Creating a profile for the 
Linear Translator” on page 93
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Adding the Linear Translator to the device file

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new Linear 
Translator to the device file unless you are adding another Linear Translator 
or replacing the existing Linear Translator. For information about device files, 
see “Devices and device file defined” on page 32.

When setting up the Linear Translator, you must:

1 Add the Linear Translator in the device file and specify how the translator 
will interact with the BioCel System robot.

2 Revise the incubator device properties to specify how the translator will 
interact with the incubator.

To add the Linear Translator to the device file:

1 In the VWorks software, open the device file and add the Linear 
Translator. See “Adding and deleting devices in the software” on page 32 
for instructions.

2 In the Linear Translator Properties area, type or select the following:

4 Set and edit the teachpoints for the 
Linear Translator.

“Setting teachpoints for the 
translator” on page 96

5 Verify the Linear Translator 
teachpoints.

“Verifying translator 
teachpoints” on page 97

Step Procedure See...

Property Description

Name The name of the Linear Translator device.
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3 In the Devices area, expand Linear Translator, and then select the Start 
stage.

4 In the Linear Translator Properties area, set up the end that will interact with 
the BioCel System robot:

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Linear Translator” on 
page 93, and then return to this step to 
select the profile.

Property Description

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.
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5 In the Devices area, select the End stage under Linear Translator.

6 In the Linear Translator Properties area, set up the end that will interact with 
the incubator robot:

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the Start 
location. This selection enables the BioCel 
System robot to move correctly to and from 
the Start location during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this location, you 
must select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Teachpoint for robot 
<Linear Translator>

The teachpoint that is set up for the Linear 
Translator. Select Start.

For setup instructions, see “Setting 
teachpoints for the translator” on page 96.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the 
Linear Translator.

Door The internal system door associated with 
this device. For the Linear Translator, this 
is one of the doors between two connecting 
systems.

Property Description
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7 Select File > Save.

To update the incubator device properties: 

1 In the Devices area, expand the incubator and select the Load/Unload or 
equivalent location.

2 In the incubator Properties area, update the fields that will enable 
interaction with the Linear Translator:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. Because the End location will only 
interact with the incubator, select <not 
accessible>.

Teachpoint for robot 
<Linear Translator>

The teachpoint that is set up for the Linear 
Translator. Select End.

For setup instructions, see “Setting 
teachpoints for the translator” on page 96.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.

Door The internal system door associated with 
this device. For the Linear Translator, this 
is one of the doors between two connecting 
systems.
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3 Select File > Save.

Creating a profile for the Linear Translator

The Linear Translator profile allows you to set up communication between the 
translator and the controlling computer. You can also set the speed at which 
the translator should transport microplates.

To create a profile:

1 In the VWorks software, open Linear Translator Robot Driver Diagnostics.

Property Description

Teachpoint for robot 
<BioCel System Robot>

Select <not accessible>.

Note: In simulation mode, select <not 
accessible>.

Teachpoint for robot 
<Linear Translator>

Select End, because this is the teachpoint 
that is set up to interact with the incubator.
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The Linear Translator Robot Driver Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.
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5 In the Profile settings area, set the following parameters:

Selection or parameter Description

Hardware type Select One-axis Linear Translator or Two-axis 
Linear Translator.

To determine whether the translator has 
two axes, try to manually rotate the plate 
stage. If it rotates, it has two axes.

Linear serial Select the serial port that connects the 
linear motor to the controlling computer.

Rotate serial port Select the serial port that connects the 
rotational motor to the controlling 
computer.

Teachpoint file Browse and select the translator 
teachpoint file you want to use.

Note: The translator teachpoint file is 
different from the system robot 
teachpoint file.

To set up translator teachpoints, see 
“Setting teachpoints for the translator” on 
page 96.

Speed Select the speed at which you want the 
translator to move: Fast, Medium, or Slow.

Velocity Type the percentage of factory- set 
maximum speed for the speed you 
selected. 

For example, if you selected Slow, you 
can set the Slow speed at 15% of the 
factory- set maximum speed.

Acceleration Type the percentage of maximum 
factory- set acceleration for the speed you 
selected. 

For example, if you selected Slow, you 
can set the Slow acceleration at 15% of 
the factory- set maximum acceleration.
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6 When you are finished, click Update this profile to save the changes.

7 Click Initialize this profile.

Setting teachpoints for the translator

To set the teachpoints for the translator, you need to:

1 Use Linear Translator Diagnostics to set a teachpoint at each end of the 
translator. One teachpoint is accessed by the BioCel System robot, the 
other teachpoint is accessed by the incubator.

2 See the robot user documentation to set a BioCel System robot teachpoint 
at the start location of the translator.

Make sure you turn off the translator motors before you start. To turn off 
the motors, see “Turning on and turning off the translator motors” on 
page 98.

3 Follow instructions in the incubator user documentation to set a teachpoint 
at the end location of the translator.

Make sure you turn off the translator motors before you start. To turn off 
the motors, see “Turning on and turning off the translator motors” on 
page 98.

To set the teachpoints using Linear Translator Diagnostics:

1 In Linear Translator Diagnostics, click the Controls tab.

2 In the Both Axes area, click Disable motors. The translator motors are turned 
off.

3 Manually push the translator plate stage to the end where the BioCel 
System robot will place or pick up microplates.

4 Manually move the BioCel System robot to the plate stage. See the robot 
user documentation to set and edit the BioCel System robot teachpoint at 
the translator.

5 In Linear Translator Diagnostics, in the Teachpoints area, select Start Location, and 
then click Teach teachpoint.

6 Manually move the translator plate stage to the end where the incubator 
will place or pick up microplates.
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7 Manually move the incubator robot to the plate stage. Use the incubator 
user documentation to set and edit the teachpoint at the translator.

8 In Linear Translator Diagnostics, in the Teachpoints area, select End Location, and 
then click Teach teachpoint.

9 In the Both Axes area, click Enable motors to turn on the translator motors.

Verifying translator teachpoints

To verify the translator teachpoints:

1 In Linear Translator Driver Diagnostics, in the Teachpoints area, select a 
teachpoint you want to verify, and then click Move to teachpoint. Check that 
the translator plate stage moved to the selected teachpoint and is 
positioned accurately. If necessary, edit the teachpoint (see “Setting 
teachpoints for the translator” on page 96).

2 For the BioCel System robot, see the robot user documentation to verify 
and edit the teachpoint:

3 For the incubator robot, follow the incubator user documentation to verify 
and edit the teachpoint.

Using Linear Translator Diagnostics

You can use the commands and parameters in the Linear Translator 
Diagnostics Controls tab to:

• Home the plate stage

• Turn on or turn off the translator motors

• Change the translator speed

• Jog the plate stage

CAUTION Use only the commands and parameters in the Controls tab as described. Do not 
click the buttons in the Calibration area. The Use current position as homing offset button 
resets the current plate stage position as the home position (0, 0). The Track length value was 
set at the factory and should not be changed. If you believe the Linear Translator is not 
working properly, contact Automation Solutions Technical Support.
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Homing the plate stage
Homing sends the plate stage to the factory- defined home position for each 
axis of motion. Home the plate stage when recovering from an emergency stop.

To home the plate stage:

1 In Linear Translator Diagnostics, click the Controls tab.

2 In the Both Axes area, click Home.

Turning on and turning off the translator motors
Turning off the translator motors allows you to move the plate stage by hand, 
making it easier to set and edit teachpoints. You must turn on the translator 
motors for operation.
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To turn on or turn off the translator motors:
In the Both Axes area, click one of the following:

Alternatively, you can turn on or turn off the motor of a single axis. To do 
this, in the X-Axis or Theta-Axis area, click either Enable motor or Disable motor to 
turn on or turn off the motor for that axis. The x- axis motor moves the plate 
stage linearly. The theta- axis motor rotates the plate stage.

Changing the translator speed
You can select the robot speed to accommodate the task you are performing. 
For example, you can select the Slow speed when you are setting teachpoints 
or diagnosing problems.

To change the translator speed:
In the Speed list, select the speed at which you want the plate stage to move: 
Fast, Medium, or Slow.

Note: The speed you select in the Controls tab applies only to the commands 
you use in the diagnostics software (Jog and Move to teachpoint).

Jogging the plate stage
Jogging the translator plate stage moves the plate stage in small, precise 
increments along one of the axes. You can jog the plate stage to fine- tune its 
position when setting teachpoints.
                                                        

Command Description

Enable motors Turns on the translator motors.

Disable motors Turns off the translator motors.
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To jog the plate stage:

In the Jog Axes area, click one of the following:

To change the jog increment, click the down arrow, and then select the desired 
increment in millimeters or degrees.

Related information

Command Description

 CCW Jogs the plate stage counterclockwise by the 
specified increment.

 CW Jogs the plate stage clockwise by the specified 
increment.

 Left Jogs the plate stage left from the current position 
by the specified increment.

 Right Jogs the robot head right from the current position 
by the specified increment.

For information about... See...

Using the Linear Translator in a 
protocol

VWorks Automation Control User 
Guide

Incubator device Incubator device driver guide

Available devices “BioCel System additional devices 
overview” on page 72
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Orbital Shaking Station 

About this topic

This topic describes the Orbital Shaking Station, explains its use, and provides 
the configuration instructions.

Description

An Orbital Shaking Station is a microplate shaker that can be installed in 
place of a platepad on the BioCel System table. For a full description of the 
Orbital Shaking Station, see the manufacturer’s documentation.

Setup workflow

Adding the Orbital Shaking Station in the device file 

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new Orbital 
Shaking Station to the device file unless you are adding another Orbital 
Shaking Station or replacing the existing Orbital Shaking Station. For 
information about device files, see “Devices and device file defined” on 
page 32.

Before you start, make sure that at the Orbital Shaking Station speed control 
(on the power cord), the speed dial is set to PC RS232. This setting allows the 
VWorks software to control the Orbital Shaking Station.

Step Procedure See...

1 Install the Orbital Shaking Station. Automation Solutions 
Technical Support

2 Add the Orbital Shaking Station in 
the device file.

“Adding the Orbital Shaking 
Station in the device file” on 
page 101

3 Create a profile for the Orbital 
Shaking Station.

“Creating a profile for the 
Orbital Shaking Station” on 
page 104

4 Set, edit, and verify the teachpoint 
for the Orbital Shaking Station.

Robot user documentation
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To add the Orbital Shaking Station to the device file:

1 In the VWorks software, open the device file and add the Teleshake 
(Orbital Shaking Station) device. See “Adding and deleting devices in the 
software” on page 32 for instructions.

2 In the Orbital Shaking Station Properties area, type or select the following:

3 In the Devices area, expand the Orbital Shaking device, and then select the 
Stage location.

4 In the Orbital Shaking Station Stage Location Properties area, type or set the 
following:

Property Description

Name The name of the Orbital Shaking Station 
device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Orbital Shaking Station” on 
page 104, and then return to this step to 
select the profile.
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5 Select File > Save.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device. Use this field 
only if a barcode reader is installed on the 
device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint to use for the 
stage location. This selection enables the 
robot to move correctly to and from the 
platepad or device during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this platepad, you 
must select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.
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Creating a profile for the Orbital Shaking Station 

The Orbital Shaking Station profile allows you to set up communication 
between the Orbital Shaking Station and the controlling computer.

To create a profile:

1 In the VWorks window, select the Orbital Shaking Station device, and then 
click Device diagnostics.

The Orbital Shaking Station Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile area.

5 In the COM port list, select the COM port number used by the Orbital 
Shaking Station.
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6 In the Module type list, select the shaking speed: Standard or High-speed.

7 Click Update this profile to save the changes.

8 Click Initialize this profile to establish communication with the Orbital 
Shaking Station.

9 Return to the device file and select the profile for the Orbital Shaking 
Station.

Using Orbital Shaking Station Diagnostics 

You can use the parameters and commands in Orbital Shaking Station 
Diagnostics to do the following for troubleshooting purposes:

• Set shaking parameters

• Start and stop shaking

To set the shaking parameters:

1 In the Orbital Shaking Station Diagnostics dialog box, click the Controls tab.

2 If you have more than one shaking station installed, select the one you 
want to use in the Select Teleshake to work with list.

3 In the RPM area, set the speed at which you want to shake the microplate.

4 In the Stir Direction area, select the direction in which you want to shake 
the microplate.

To start or stop shaking:

Click Start or Stop.
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Related information

For information about... See...

Using the Orbital Shaking Station 
in a protocol

VWorks Automation Control User 
Guide

Set teachpoints at the Orbital 
Shaking Station

Robot user documentation
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Phantom Robot 

About this topic

This topic describes the Phantom Robot, explains its use, and provides the 
configuration instructions.

Description

In the VWorks software, every task is associated with a device. The Phantom 
Robot is the virtual device that represents the operator who will manually 
perform a task (move labware) during a programmed pause in a protocol run. 
The software displays a message during the pause. You can indicate the 
completion of the task in the message dialog box so the protocol can continue.

Setup workflow

Adding the Phantom Robot in the device file 

The VWorks software is set up with the correct device configuration. You do 
not need to add a new Phantom Robot to the device file unless you want to 
make adjustments. For information about device files, see “Devices and device 
file defined” on page 32.

To add the Phantom Robot to the device file:

1 In the VWorks software, open the device file and add the Phantom Robot. 
See “Adding and deleting devices in the software” on page 32 for 
instructions.

2 In the Phantom Robot Properties area, type or select the following:

Step Procedure See...

1 Add the Phantom Robot in the 
device file.

“Adding the Phantom Robot 
in the device file” on 
page 107

2 Create a profile for the Phantom 
Robot.

“Creating a profile for the 
Phantom Robot” on page 108
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3 Select File > Save.

Creating a profile for the Phantom Robot 

To create a profile for the Phantom Robot:

1 In the VWorks window, select the Phantom Robot device, and then click Device 
diagnostics.

Property Description

Name The name of the Phantom Robot.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Phantom Robot” on 
page 108, and then return to this step to 
select the profile.
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The Phantom Robot Diagnostics dialog box opens.

2 In the Profiles tab, click Create new profile.

3 In the Create Profile dialog box that opens, type a name for the profile, 
and then click OK.

4 Optional. If you want the software to prompt the operator for each robot 
movement, select Prompt user for each robot move.

5 Click Update this profile to save the changes.

6 Click Initialize this profile.

7 Return to the device file and select the profile for the Phantom Robot 
device.

                                                        



A   Additional BioCel System Devices
Phantom Robot

110 BioCel System User Guide

Related information

For information about... See...

Mounting devices on the docking 
table

Automation Solutions Technical Support

Devices that can be integrated in 
the BioCel System

“Device integration options” on page 20

Available devices “BioCel System additional devices 
overview” on page 72
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Plate Hotel 

About this topic

This topic describes the Plate Hotel, explains its uses, and provides the 
configuration instructions.

Description

A Plate Hotel is a vertical rack that stores microplates. The microplates sit on 
individual shelves and are not stacked directly on top of one another. 
Therefore, the microplates can be accessed randomly.

Setup workflow
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Step Procedure See...

1 Install the Plate Hotel. Automation Solutions 
Technical Support

2 Add the Plate Hotel in the device 
file.

“Adding the Plate Hotel in the 
device file” on page 112

3 Create a profile for the Plate Hotel. “Creating a profile for the 
Plate Hotel” on page 114

4 Set, edit, and verify the teachpoints 
for the Plate Hotel.

“Setting teachpoints for the 
Plate Hotel or Plate Hub” on 
page 130
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Adding the Plate Hotel in the device file

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new Plate 
Hotel to the device file unless you are adding another Plate Hotel or replacing 
the existing Plate Hotel. For information about device files, see “Devices and 
device file defined” on page 32.

Before you start
Before setting up the Plate Hotel in the VWorks software, determine whether 
you want to use the VWorks software inventory management system to track 
groups of labware moving into and out of the Plate Hotel.

If you want to use the inventory management system with the Plate Hotel, you 
will need to use the Plate Hub Carousel plugin by adding the Plate Hub 
Carousel device in the device file. The Plate Hub Carousel plugin has features 
that enable inventory management, and Plate Hub Carousel Diagnostics 
includes selections for setting up the Plate Hotel.

If you do not want to use the labware inventory manager with the Plate Hotel, 
you can add the Plate Hotel device in the device file.

For information about setting up and using the inventory management system, 
see the VWorks Automation Control Setup Guide.

Procedure

To add the Plate Hotel to the device file:

1 In the VWorks software, open the device file and add one of the following:

• Plate Hub Carousel (if you want to use labware inventory manager)

• Plate Hotel (if you do not want to use labware inventory manager)

See “Adding and deleting devices in the software” on page 32 for 
instructions.

2 In the Plate Hub Carousel Properties or the Plate Hotel Properties area, type or 
select the following:
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3 In the Devices area, expand Plate Hotel, and then select Slot 1.

Note: If you added the Plate Hub Carousel device, only Slot 1 appears. If 
you added the Plate Hotel device, 16 slots appear.

4 In the Plate Hotel Slot 1 Properties or Plate Hub Carousel Slot 1 Properties area, type 
or set the following:

Property Description

Name The name of the Plate Hotel device.

Note: If you added the Plate Hub Carousel 
device, make sure you provide a name that 
clearly shows it is a Plate Hotel device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Plate Hotel” on page 114, 
and then return to this step to select the 
profile.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use this field only if a barcode reader is 
installed on the device.
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5 Select File > Save.

Creating a profile for the Plate Hotel

If you added the Plate Hub Carousel device, use Plate Hub Carousel 
Diagnostics to create a profile for the Plate Hotel. See “Creating a profile in 
Plate Hub Carousel Diagnostics” on page 115.

If you added the Plate Hotel device, use Plate Hotel Diagnostics to create a 
profile for the Plate Hotel. See “Creating a profile in Plate Hotel Diagnostics” 
on page 116.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the Slot 1 
(bottommost slot) location. This selection 
enables the robot to move correctly to and 
from the Slot 1 location during a protocol 
run.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Top teachpoint for robot 
<BioCel System Robot>

Plate Hub Carousel Plate Hotel only. The 
name of the teachpoint for the topmost slot 
location.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid a 
deadlock.

This property is only applicable if you are 
setting up the Plate Hotel using Plate Hotel 
Diagnostics.

A Plate Hotel that is set up using Plate Hub 
Carousel Diagnostics cannot be used for 
deadlock avoidance.

Door The internal system door associated with 
this device.

This property is not applicable for the Plate 
Hotel.

Property Description
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Creating a profile in Plate Hub Carousel Diagnostics

To create a profile in Plate Hub Carousel Diagnostics:

1 In the VWorks software, open Plate Hub Carousel Diagnostics.

The Plate Hub Carousel Diagnostics dialog box opens.

2 Click Create a new profile. The Create Profile dialog box opens.

3 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.

4 In the Profile settings area:

a Select Used as plate hotel.

b Type the Number of slots in the Plate Hotel.

c Type the Slot spacing, or the vertical distance, in millimeters, between 
each Plate Hotel slot. 

5 When you are finished, click Update this profile to save the changes.
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6 Click Initialize this profile.

7 Return to the device file and select the profile for the Plate Hotel device.

Creating a profile in Plate Hotel Diagnostics

To create a profile in Plate Hotel Diagnostics:

1 In the VWorks software, open Plate Hotel Diagnostics.

The Plate Hotel Diagnostics dialog box opens.

2 Click Create a new profile. The Create Profile dialog box opens.

3 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.

4 In the Profile settings area, type the number of slots in the Plate Hotel.

5 When you are finished, click Update this profile to save the changes.

6 Click Initialize this profile.
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7 Return to the device file and select the profile for the Plate Hotel device.

Setting teachpoints for the Plate Hotel

To set, edit, and verify teachpoints for the Plate Hotel, see the appropriate 
robot user guide.

When you set the teachpoints, use the provided teaching jig or teaching plate 
to set a teachpoint at the following locations:

• If the Plate Hotel is set up using Plate Hub Diagnostics, set a teachpoint at:

– Top shelf

– Bottom shelf

• If the Plate Hotel is set up using Plate Hotel Diagnostics, set a teachpoint 
at all 16 slots.

Related information

For information about... See...

Using the Plate Hotel or the Plate 
Hub in a protocol

VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 72
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Plate Hub Carousel

About this topic

This topic describes the Plate Hub Carousel, explains its uses, and provides the 
configuration instructions.

Description

Two models of the Plate Hub Carousel are available: Landscape (1) and 
Portrait (2). Both consist of racks (cassettes) that store microplates, tip boxes, 
or other labware. 

The capacities of both models are as follows:

Note: You can use a combination of the microplate, tall labware, and custom 
cassettes in each model to meet your application requirements.

The Plate Hub Carousel must be used with the VWorks software inventory 
management system for random and dynamic access. For information about 
setting up and using the software inventory management system, see the 
VWorks Automation Control Setup Guide.

1 2

Capacity (landscape and portrait models)

Cassettes 12

Slots in microplate cassettes 16

Slots in tall labware cassettes 7

Slots in custom cassettes Number of slots varies by system 
configuration
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Setup workflow

Adding the Plate Hub Carousel in the device file

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new Plate 
Hub Carousel to the device file unless you are adding another Plate Hub 
Carousel or replacing the existing Plate Hub Carousel. For information about 
device files, see “Devices and device file defined” on page 32.

For information about setting up and using the inventory management system, 
see the VWorks Automation Control Setup Guide.

To add the Plate Hub to the device file:

1 In the VWorks software, open the device file and add the Plate Hub 
Carousel. See “Adding and deleting devices in the software” on page 32 for 
instructions.

2 In the Plate Hub Carousel Properties area, type or select the following:

Step Procedure See...

1 Install the Plate Hub Carousel. Automation Solutions 
Technical Support

2 Add the Plate Hub Carousel in the 
device file.

“Adding the Plate Hub 
Carousel in the device file” 
on page 119

3 Create a profile for the Plate Hub 
Carousel.

“Creating a profile for the 
Plate Hub” on page 122

4 Set up communication and selecting 
the rotation speed.

“Setting up communication 
and selecting the rotation 
speed” on page 123

5 Configure the cassettes. “Configuring the Plate Hub 
Carousel cassettes” on 
page 123

6 Set, edit, and verify the teachpoints 
for the Plate Hub Carousel.

“Setting teachpoints for the 
Plate Hotel or Plate Hub” on 
page 130
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3 In the Devices area, expand Plate Hub, and then select Slot 1.

4 In the Plate Hub Carousel Slot 1 Properties area, type or set the following:

Property Description

Name The name of the Plate Hub Carousel device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Plate Hub” on page 122, 
and then return to this step to select the 
profile.
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5 Select File > Save.
                                                        

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use this field only if a barcode reader is 
installed on the device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the Slot 1 
(bottom- most slot) location. This selection 
enables the robot to move correctly to and 
from the Slot 1 location during a protocol 
run.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Top teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the top-
most slot location.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the Plate 
Hub Carousel.
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Creating a profile for the Plate Hub 

You use Plate Hub Carousel Diagnostics to create a profile for the Plate Hub 
Carousel. The Plate Hub Carousel profile allows you to set up communication 
between the Plate Hub Carousel and the controlling computer. You can also set 
the speed at which the carousel turns and indicate the number and type of 
cassettes that will be used.

To create a profile:

1 In the VWorks software, open Plate Hub Carousel Diagnostics.

The Plate Hub Carousel Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.
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Setting up communication and selecting the rotation speed

To set up communication with the Plate Hub Carousel and to select the rotation speed:

1 In the Profile settings area:

• In the Serial port list, select the serial port that connects the Plate Hub 
to the controlling computer.

• In the Default speed list, select the speed at which you want the Plate 
Hub to rotate: Slow, Medium, or Fast.

Note: Do not select Used as plate hotel.

2 In the Speed Definitions area, define the three possible speeds (High, 
Medium, Low) as a percentage of the factory- set maximum speed. To do 
this:

a In the Speed list, select the speed you want to define.

b In the Velocity box, type the percentage of factory- set maximum speed. 
For example, you can set the Slow speed at 15% of the factory- set 
maximum speed.

c In the Acceleration box, type the percentage of maximum factory- set 
acceleration. For example, you can set the Slow acceleration at 15% of 
the factory- set maximum acceleration.

3 Click Update this profile to save the changes.

4 Click Initialize this profile to establish communication with the Plate Hub 
Carousel.

Configuring the Plate Hub Carousel cassettes

This section explains the following:

• Adding and managing custom cassettes

• Configuring the cassettes in the Plate Hub Carousel

If you have custom cassettes, you should add them before configuring the Plate 
Hub Carousel cassettes. If you do not have custom cassettes, proceed to 
configure the cassettes.
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Adding and managing custom cassettes

To add a custom cassette:

1 In the Profiles tab, select Enable Editing Cassette Details. The Edit Custom 
Cassettes button becomes available.

2 Click Edit Custom Cassettes.

The Edit Custom Cassettes dialog box appears and displays two tables: 
Default Cassettes and Custom Cassettes.
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The Default Cassettes table lists default microplate and tall labware 
cassettes that are shipped with the Plate Hub Carousel. The table displays 
the cassette name, the number of slots in the cassette, the slot spacing, 
and the type of cassette. The cassette names are defined as follows:

Cassette name Description

Landscape 16 Stores up to 16 microplates that are in the 
landscape orientation. This cassette is not 
removable and does not have a handle at the top. 

Landscape 7 Stores up to 7 tall labware, such as tip boxes, that 
are in the landscape orientation. This cassette is 
not removable and does not have a handle at the 
top.

Portrait 16 Stores up to 16 microplates that are in the portrait 
orientation. This cassette is not removable and does 
not have a handle at the top.

Portrait 7 Stores up to 7 tall labware, such as tip boxes, that 
are in the portrait orientation. This cassette is not 
removable and does not have a handle at the top.

Standard 16 Stores up to 16 microplates that are in the 
landscape orientation. This cassette has a handle at 
the top.

Note: Standard 16 cassettes are provided in the 
list to ensure backward compatibility with older 
Plate Hub Carousel models. They only appear in 
the table if you have the older Plate Hub 
Carousel.

Standard 6 or 
Standard 8

Stores up to 6 or 8 tall labware, such as tip boxes, 
that are in the landscape orientation. This cassette 
has a handle at the top.

Note: Standard 6 and Standard 8 cassettes are 
provided in the list to ensure backward 
compatibility with older Plate Hub Carousel 
models. They only appear in the table if you have 
the older Plate Hub Carousel.
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The Custom Cassettes table lists cassettes whose number of slots varies by 
system configuration. The table is empty if you have not yet created any 
custom cassettes.

3 To add a new custom cassette, click Add. The Cassette Properties dialog 
box opens.

4 Specify the following:

                                                        

Property Description

Cassette name Type a name for the custom cassette. Use a name 
that will allow you to easily identify it later.

Number of slots Type the number of slots in the cassette.

Slot spacing (mm) Type the vertical distance, in millimeters, between 
each slot. 

To calculate the slot spacing:

1 Open the robot diagnostics. Locate the z- axis 
values of the teachpoints for the topmost and 
bottommost slots.

2 Calculate the slot spacing as follows:

Spacing = (Zn -  Z1) / (# slots -  1)

where Zn is the z- axis value of the topmost 
slot, and Z1 is the z- axis value of the 
bottommost slot.

For example, Z1 is - 68.9 mm, and Zn is 387.0 mm. 
The cassette has 16 slots, so the slot spacing is:

Spacing = (387.0 mm -  (- 68.9 mm))/(16 -  1)

= 30.4 mm

Type Select the orientation of the cassette: Landscape or 
Portrait.

IMPORTANT All of the cassettes in the Plate Hub 
Carousel must have the same orientation.
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3 When you are finished, click OK to save the changes and return to the Edit 
Custom Cassettes dialog box. The newly created cassette appears in the 
Custom Cassettes table.

4 To edit a custom cassette, select the cassette in the table, and then click 
Edit.

5 To delete a custom cassette, select the cassette in the table, and then click 
Delete.

6 When you are finished, click Apply to save the changes and return to the 
Plate Hub Carousel Diagnostics dialog box.

Configuring the cassettes in the Plate Hub Carousel
Before you configure the Plate Hub Carousel cassettes, determine the number 
of slots you will use in each cassette. For example, you might only want to use 
the first 10 of the 16 slots in some cassettes. When determining the number of 
slots, be aware that slot 1 is the bottommost slot.

You configure the Plate Hub Carousel cassettes using the table at the bottom of 
the Profiles tab.
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To configure the cassettes in the Plate Hub Carousel: 

1 In the Cassette name column, select the desired cassette.

Note: Standard cassette selections are provided in the Cassette name list 
to ensure backward compatibility with older Plate Hub Carousel models.

2 If you do not plan to use all of the slots in the cassettes:

a Select Enable Editing Cassette Details. The fields in the Accessible Slots 
from Bottom column become writable.

b Type a new value in the Accessible Slots from Bottom column.

3 When you are finished, click Update this profile to save the changes.

4 Return to the device file and select the profile for the Plate Hub Carousel 
device.

Using Plate Hub Diagnostics 

You can use the commands and parameters in the Plate Hub Carousel 
Diagnostics Controls tab to:

• Set the home position.

• Turn the carousel to a specific position.

To set the home position:

1 In the Servo area, click Servo off to turn off the Plate Hub Carousel motors.

2 Manually turn the carousel so that cassette 1 lines up with the robot. You 
can use the teaching jig to make sure the alignment is accurate. For 
information about using the teaching jig, see the robot user documentation.

3 When you are finished aligning the cassette 1 with the robot, move the 
robot and its grippers away from the carousel.

4 In the Servo area, click Servo on to turn on the Plate Hub Carousel motors.
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5 Click Set as home in the Home Stop area.

To turn the Plate Hub:

1 Move the robot away from the Plate Hub.

2 To move a cassette to the cassette- 1 home position:

a In the Movement area, in the list next to the Move to cassette button, 
select the cassette number.

b Click Move to cassette. The carousel turns until the selected cassette is at 
the cassette- 1 home position.

3 To turn the carousel a specified number of degrees relative to the home 
position:

a In the box next to the Move to degree button, type an angular position 
(0–360) in degrees.

b Click the Move to degree button. The carousel turns the specified number 
of degrees from the home position.
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4 To return the carousel to its home position, in the Home Stop area, click Go 
Home.

Setting teachpoints for the Plate Hotel or Plate Hub

To set, edit, and verify teachpoints for the Plate Hub, see the robot user 
documentation.

When you set the teachpoints, use the provided teaching jig to set a teachpoint 
at the following locations:

• Top shelf

• Bottom shelf

Related information

For information about... See...

Using the Plate Hotel or the Plate 
Hub in a protocol

VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 72
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Platepad 

About this topic

This topic describes the standard platepad, explains its use, and provides the 
configuration instructions.

Description

The standard platepad is a metal block on which a single microplate sits. 
Raised tabs on each side keeps the microplate in place.

Setup workflow

Adding the platepad in the device file

To place a microplate on or remove a microplate from a platepad, you must 
add the platepad device in the device file. The VWorks software is set up with 
the correct device configuration. You do not need to add a new platepad to the 
device file unless you want to add another platepad or replace the existing 
platepad. For information about device files, see “Devices and device file 
defined” on page 32.

To add a platepad to the device file:

1 In the device file, add the Plate Pad. See “Adding and deleting devices in 
the software” on page 32 for instructions.

                                                        

Step Procedure See...

1 Install the platepad. Automation Solutions 
Technical Support

2 Add the platepad in the device file. “Adding the platepad in the 
device file” on page 131

3 Set, edit, and verify the teachpoints 
for the platepad.

Robot user documentation
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2 In the PlatePad Properties area, type the name of the platepad.

3 In the Devices area, expand the Plate Pad, and then select the Stage location.

4 In the PlatePad Stage Location Properties area, type or set the following:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.
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5 Select File > Save.

Related information

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device. Use this field 
only if a barcode reader is installed on the 
device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint to use for the 
stage location. This selection enables the 
robot to move correctly to and from the 
platepad or device during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this platepad, you 
must select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.

Property Description

For information about... See...

Setting a platepad teachpoint Robot user documentation

Available devices “BioCel System additional devices 
overview” on page 72
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Vacuum Delid Station 

About this topic

This topic describes the Vacuum Delid Station, explains its use, and provides 
the configuration instructions.

Description

The Vacuum Delid Station is a static arm that sits over the waste- bin opening 
in the BioCel System table. Vacuum in the suction cups is used to remove 
labware lids that are dropped into the waste bin below the table.

Note: Vacuum is created using an air source.

Setup workflow

Adding the Vacuum Delid Station in the device file 

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new vacuum-
based lid remover to the device file unless you are adding another vacuum-

Vacuum-Based Delidder

00308

Step Procedure See...

1 Install the Vacuum Delid Station. Automation Solutions 
Technical Support

2 Add the Vacuum Delid Station in 
the device file.

“Adding the Vacuum Delid 
Station in the device file” on 
page 134

3 Set, edit, and verify the teachpoint 
for the Vacuum Delid Station.

“Setting the teachpoint at the 
Vacuum Delid Station” on 
page 137
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based lid remover or replacing the existing vacuum- based lid remover. For 
information about device files, see “Devices and device file defined” on 
page 32.

To add the Vacuum Delid Station to the device file:

1 In the device file, add the Vacuum Delid Station device. See “Adding and 
deleting devices in the software” on page 32 for instructions.

2 In the Vacuum Delid Station Properties area, type or select the following:

3 In the Devices area, expand the Vacuum Delid Station, and then select the 
Stage location.

                                                        

Property Description

Name The name of the Vacuum Delid Station 
device.

Output point The BioCel I/O Interface port number that 
is used to turn on or turn off the vacuum.

Sensor input point The BioCel I/O Interface port number that 
is used to detect whether the vacuum is 
turned on or turned off.
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4 In the Vacuum Delid Station Location Properties area, type or set the following:

5 Select File > Save.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. This selection enables the robot to 
move correctly to and from the Vacuum 
Delid Station during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this Vacuum Delid 
Station, you must select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

This property is not applicable to the 
Vacuum Delid Station.
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Setting the teachpoint at the Vacuum Delid Station

This section presents guidelines for setting a Vacuum Delid Station teachpoint. 
For detailed instructions on how to set a teachpoint, see the robot user 
documentation.

Direct Drive Robot and BenchBot Robot guidelines

When you set the Vacuum Delid Station teachpoint:

1 Install the provided teaching jig in the robot grippers.

2 Position the robot such that it is centered over the waste bin, and the 
bottom of the teaching jig is touching the top of the metal bar of the 
Vacuum Delid Station.

3 Set the teachpoint. Make sure you:

• Set Approach Ht (with labware) and Approach Ht (no labware) at 0.

• For Place Custom Action, select Vacuum delid.

4 Save the teachpoint.

Related information

For information about... See...

Setting up the BioCel I/O Interface BioCel System User Guide, Revision 01, 
August 2010

Using the Vacuum Delid Station in 
a protocol

VWorks Automation Control User 
Guide

Lid Hotel Station “Lid Hotel Station” on page 81

Available devices “BioCel System additional devices 
overview” on page 72

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Waste bin 

About this topic

This topic describes the waste bin, explains its use, and provides the 
configuration instructions.

Description

The waste bin is a container that receives waste in the BioCel System. The 
software views the waste bin as a location (teachpoint) where the robot 
releases the labware that it has in its grippers. A receptacle for trash is 
typically positioned under this teachpoint.

Because it is a teachpoint and can be accessed by the robot, the waste bin is 
treated as a device in the software. 

Setup workflow

Adding the waste bin in the device file 

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new waste 
bin to the device file unless you are adding another waste bin or replacing the 
existing waste bin. For information about device files, see “Devices and device 
file defined” on page 32.

If the BioCel System is designed with an environmental chamber and an 
automated door separates the waste bin from the system, make sure you also 
add the door to the device file.

To add a waste bin to the device file:

1 In the VWorks software, open the device file and add the Waste Bin device. 
See “Adding and deleting devices in the software” on page 32 for 
instructions.

                                                        

Step Procedure See...

1 Install the waste bin. Automation Solutions 
Technical Support

2 Add the waste bin in the device 
file.

“Adding the waste bin in the 
device file” on page 138

3 Set, edit, and verify the teachpoints 
for the waste bin.

Robot user documentation



139

A   Additional BioCel System Devices
Waste bin

BioCel System User Guide

2 In the Waste Bin Properties area, type a name for the Waste Bin.

3 In the Devices area, expand Waste Bin -  1, and then select Hole, the 
location where the robot will drop waste.

4 In the Waste Bin Hole Location Properties area, type or set the following:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only tip 
boxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.
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5 Select File > Save.

To add a waste-bin door to the device file:

1 In the VWorks software, add the waste bin Door device. See “Adding and 
deleting devices in the software” on page 32 for instructions.

2 When setting up the waste bin door, be sure to specify the BioCel I/O 
Interface input and output signals to be used. For detailed instructions, 
contact Automation Solutions Technical Support.

3 Select File > Save.

Related information

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use this field only if a barcode reader is 
installed on the device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint to use for the 
Hole location. This selection enables the 
robot to move correctly to and from the 
Waste Bin during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this Waste Bin, 
you must select that teachpoint.

Note: If the computer is not connected to 
the BioCel System and you want to simulate 
a run, select <accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

This property is not applicable to the Waste 
Bin.

Property Description

For information about... See...

Setting a waste teachpoint Robot user documentation

Setting up the BioCel I/O Interface BioCel System User Guide, Revision 01, 
August 2010

Available devices “BioCel System additional devices 
overview” on page 72

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Weigh Pad 

About this topic

This topic describes the Weigh Pad, explains its use, and provides the 
configuration instructions.

Description

A Weigh Pad is an electronic monitor that checks the percentage of liquid in 
the bottle resting on the Weigh Pad. By monitoring the weight of the bottle, the 
Weigh Pad controls when the Pump Module is activated. The Weigh Pad works 
with the Pump Module to maintain an optimum level of liquid and ensures the 
bottle is not overfilled. If no Pump Module is used, an alarm can be set up to 
sound when the liquid level is too low or too high.

Two sizes of Weigh Pads are available: Large and small. The Weigh Pad size 
should accommodate the bottle size.

Setup workflow

Note: Weigh Pads are typically installed under the system deck and do not 
interact with the robot. Therefore, you do not need to set teachpoints for 
Weigh Pads.

00110
Weighpads

Step Procedure See...

1 Install the Weigh Pad. Automation Solutions 
Technical Support

2 Add the Weigh Pad in the device 
file.

“Adding the Weigh Pad in the 
device file” on page 142

3 Create a profile for the Weigh Pad. “Creating a profile for the 
Weigh Pad” on page 142

4 Set up the bottle library. “Setting up the bottle library” 
on page 144

5 Calibrate the Weigh Pads. “Calibrating the Weigh Pads” 
on page 145

6 View the bottle status. “Viewing the bottle status” on 
page 146
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Adding the Weigh Pad in the device file 

The VWorks software device file is set up with the correct devices and device 
configurations for your BioCel System. You do not need to add a new Weigh 
Pad to the device file unless you are adding another Weigh Pad or replacing 
the existing Weigh Pad. For information about device files, see “Devices and 
device file defined” on page 32.

To add the Weigh Pad to the device file:

1 In the VWorks software, open the device file and add the Weigh Pad. See 
“Adding and deleting devices in the software” on page 32 for instructions.

2 In the Weigh Pad Properties area, type or select the following:

3 Select File > Device File > Save.

Creating a profile for the Weigh Pad 

The Weigh Pad profile allows you to set up communication between the Weigh 
Pad and the controlling computer.

To create a profile:

1 In the VWorks software, open Weigh Pad Diagnostics.

Property Description

Name The name of the Weigh Pad device.

Profile The profile associated with the device.

Select the desired profile from the list. If you 
have not created a profile, see “Creating a 
profile for the Weigh Pad” on page 142, and 
then return to this step to select the profile.
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The Weigh Pad Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile area.

5 In the Profile Properties area:

a In the COM port list, select the serial port that connects the Weigh Pad 
to the controlling computer.

b In the Number of list, select the number of Weigh Pads that are installed.

c If you are not sure how many Weigh Pads are connected to the system, 
click Auto-detect modules. The Number of Weigh Pads updates.
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6 Click Update this profile to save the changes.

7 Click Initialize this profile to establish communication with the Weigh Pad.

8 Return to the device file and select the profile for the Weigh Pad device.

Setting up the bottle library 

For each bottle you want the system to monitor, you must specify the weight 
of the bottle and the density of its contents. The software will use the 
information to maintain optimum liquid level and prevent overfilling.

To set up the bottle library:

1 In Weigh Pad Diagnostics, click the Bottle Library tab.

2 In the Bottle Profiles area, click Create a new bottle. A new default bottle name 
appears in the Select list.

3 To change the bottle name, double- click the default bottle name, type a 
new name, and then click Rename this bottle. The new name appears in the 
Select list.
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4 In the Bottle Properties area:

a In the Mass of empty bottle box, type the mass (weight) of the empty 
bottle in grams.

b In the Density of liquid box, type the density of the liquid in grams per 
liter.

5 Click Update this bottle.

6 Repeat steps 2 through 5 for the remaining bottles.

Calibrating the Weigh Pads 

To ensure the system accurately monitors the bottles and their contents, you 
must calibrate the Weigh Pads.

To calibrate the Weigh Pads:

1 In Weigh Pad Diagnostics, click the Calibration tab.
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2 In the Weigh Pad Calibration and Readings table, select the Weigh Pad you want 
to calibrate.

3 Click Calibrate selected pads. A dialog box opens. Follow the instructions in 
the dialog box to add or remove the liquid you want to use for the 
calibration process. If the calibration is correct for the density of the 
liquid, the dialog box displays a volume, in milliliters.

4 Place the empty bottle on the Weigh Pad.

5 Click Tare selected pads to set the Weight and Volume reading at 0.

6 When you are finished calibrating and taring the Weigh Pad, click OK to 
save the changes.

Viewing the bottle status

To view the bottle status:

1 In Weigh Pad Diagnostics, click the Calibration tab.

2 In the Weigh Pad Calibration and Readings table, check the following:

Related information

Column Description

Pad # The numeric identifier that is 
assigned to a Weigh Pad as it is 
added in the software.

Pad name The name associated with the 
Weigh Pad.

You can provide a name for the 
Weigh Pad. To do this, double-
click in the Pad name cell, and 
then type a name.

Bottle type The bottle on the Weigh Pad. The 
bottle type information is 
obtained from the bottle profile.

Weight, g The current weight of the bottle 
and its contents.

Volume, mL The current volume of liquid in 
the bottle. The software 
calculates the volume from the 
bottle information (weight of 
empty bottle and liquid density).

Calibration mass, g The weight used to calibrate the 
Weigh Pad.

For information about... See...

Using the Weigh Pad in a protocol VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 72
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Block diagrams

This appendix provides block diagrams and descriptions of the 
following:

• “Power system” on page 148

• “Air system” on page 152

• “Vacuum system” on page 154
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Power system

About this topic

This topic summarizes the power system of the BioCel System. Becoming 
familiar with how your BioCel System is connected will help you to understand 
the behavior of your BioCel System and solve problems.

Overview diagrams

The following diagrams summarize the power system and illustrate typical 
connections. Both AC and DC power circuits are shown, but most data 
connections are not. Those elements that lie inside the Automation Control 
Unit are not included.
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Figure Auxiliary power

Main power

The main AC power enters the Automation Control Unit, passes through the 
main disconnect (AC) switch, through the main fuses inside the Automation 
Control Unit, and out to the AC output ports (NON- SWITCHED AC, SWITCHED 
AC).

If the system configuration includes a UPS, the main AC power passes through 
the UPS before entering the Automation Control Unit.

Auxiliary power

One or more electrical lines (auxiliary power) supply current to devices that do 
not require backup power supply and can operate independently of the 
Automation Control Unit. Some examples of these devices include:

• Cooling and heating water baths

• Incubators (environmental control components only; the robotics 
component must connect to the UPS, which is connected to the Automation 
Control Unit)

• Vacuum pumps

• Environmental controller console that houses the controllers for the main 
BioCel System (not for any separate environmental enclosures)

Because these devices are not connected to the Automation Control Unit and 
are on an independent electrical circuit, they are not affected by emergency 
stops or interlocks. Unless they are connected to another UPS, they will not 
receive backup power supply during a power outage.

UPS connections

From the UPS, current is passed to the Automation Control Unit, through the 
main disconnect (AC) switch and the main fuses, then to the rest of the BioCel 
System.

Without the UPS EPO cable (default setup)
By default, the UPS emergency power- off (EPO) cable is not installed between 
the UPS and the Automation Control Unit. As a result, turning off the power at 
the Automation Control Unit does not turn off the UPS, and devices that are 
connected directly to the UPS will remain on. These devices include the 
computer, computer monitor, and communication hubs. This setup allows you 
to continue to work on the computer and use the lights even though the 
system has been shut down.

AC

Env. Ctrl SystemChiller Incubator env Vacuum pump
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With the UPS EPO cable
If the UPS EPO cable is installed, turning off the power at the Automation 
Control Unit will cut power to the UPS, thus turning off devices that are 
connected directly to the UPS. Therefore, make sure you properly shut down 
and turn off those devices, such as the computer, before shutting down the 
system.

Non-switched AC and DC power

The blue lines in the power block diagram represent either AC or DC passed to 
devices that are: 

• Equipped with an emergency- stop circuit. Examples of such devices include 
the system robot, BenchCel Microplate Handler, Bravo Platform, Vertical 
Pipetting Station, and Plate Hub Carousel.

• Not equipped with an emergency- stop circuit and have no moving parts. 
Examples of such devices include the barcode reader, lights, fans, and 
docking tables with the QuickDock feature. The lights, fans, and docking 
tables are connected via a 24 VDC power supply.

The non- switched (blue) power ports are on a pre- emergency- stop circuit. 
Therefore, devices that do not have an emergency- stop circuit are not affected 
by emergency stops and a tripped interlock.

Switched AC and DC power

The red lines in the power block diagram represent either AC or DC passed to 
devices that are not equipped with an emergency- stop circuit but have moving 
parts. Examples of such devices include the Labware MiniHub, PlateLoc Sealer, 
and Labware Stacker.

The switched (red) power ports are on a post- emergency- stop circuit. Power is 
cut from devices connected to these ports during an emergency stop.

Emergency-stop button and the interlock system

The safety interlock system creates a circuit with the emergency- stop relay. 
Pressing the emergency- stop button will open the circuit, thus stopping the 
robot and other devices that are connected to the emergency- stop circuit. In 
addition, power is cut from devices on the switched (red) AC and DC circuits.

Opening a system door or interrupting the Light Curtain will also disrupt the 
safety interlock circuit and stop the robots and devices that are connected to 
the emergency- stop circuit. However, power remains on the switched (red) AC 
and DC circuits to permit these devices to complete their current tasks before 
pausing.

Note: Disrupting the interlock circuit engages the z- axis brakes in the system 
robot, Vertical Pipetting Station, and the Bravo Platform. The brakes prevent 
the robot and pipette head from dropping, thus preventing damage and 
reducing a crushing hazard.

IMPORTANT After an emergency- stop event has occurred, the reset button 
must be pressed to reset the emergency- stop relay to a position that allows 
current to flow. For more information about recovering from an emergency 
stop, see the BioCel System Safety Guide.
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5 VDC digital input

5 VDC is passed from the Automation Control Unit to sensors in the system. 
The sensors are found in devices such as the Vacuum Delid Station and pass-
through gates. A spill detection sensor is found in the liquid cabinet.

Note: The 5 VDC ports also accept TTL/CMOS logic input signals from the 
sensors.

For more information about the 5 VDC DIGITAL IN ports, see the Automation 
Control Unit User Guide. For information about managing signals from the 
sensors, see the lab automation software user documentation, such as the 
VWorks Automation Control User Guide.

Related information

For information about... See...

Systems affected by interlocks and 
emergency stops

“Power system” on page 148

Stopping a run in an emergency BioCel System Safety Guide

Turning the BioCel System off “Starting up and shutting down the 
BioCel System” on page 28
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Air system

Air and power interaction

The following diagram shows how the air and power systems interact. 
Becoming familiar with these systems will help you to understand the behavior 
of your BioCel System and solve problems.

Air system description

Air is used on the BioCel System to:

• Move parts, such as the Labware Stacker grippers and Vertical Pipetting 
Station shelves

• Create a vacuum, such as for the Vacuum Delid Station

The flow of air through the system is controlled by air- pressure regulators. 
Many devices have their own built- in regulators. Air pressure to other parts is 
controlled by regulators in the air distribution panel of the BioCel System.

The diagram above shows how air to the BioCel System can be cut off:

• Turning off the main power at the Automation Control Unit

• Turning off the main air shutoff valve in the air distribution panel

• Pressing an emergency- stop button (for emergency stops only)
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Related information

For information about... See...

Power system “Power system” on page 148

Vacuum system “Vacuum system” on page 154

Emergency stop BioCel System Safety Guide
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Vacuum system

Vacuum flow diagram

The following diagram shows the vacuum flow in the optional vacuum system.

Vacuum system description

A vacuum may be used on the BioCel System for:

• Filtration stations

• Suction to hold plates flat on a Vertical Pipetting Station shelf

• Third- party devices

The vacuum can be supplied by a pump or house vacuum system. If a house 
vacuum system is used, the main vacuum line enters the BioCel System with 
the other external connections. If a pump is used, it will be located on the 
floor of the BioCel System.

A reserve vacuum tank may be used to ensure an instantaneous vacuum 
supply.

Waste liquid produced by filtration stations is collected in one or more waste 
containers.

Vacuums are also created in devices using vacuum ejectors that create the 
vacuum at the site where it is required, such as at the Vacuum Delid Station. 
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Related information

For information about... See...

Power system “Power system” on page 148

Air system “Air system” on page 152

Emergency stop BioCel System Safety Guide
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Index
A
Acceleration parameter, 95
accessories. See devices
air

connections, 12
controlling flow, 152
filter, 12
leaks, 65
pressure regulation, 12
shutoff valve, 12, 152
switch, 152
system, 152
turning off, 31

automation control software, 2, 21, 30
Automation Control Unit, 7, 16, 72
Automation Solutions devices, 20

B
barcode readers

adding in device file, 75
aligning, 78
auxiliary, 72, 74
power supply, 18
testing, 78

BenchBot Robot
axes, 13
diagnostics, 22
elbow, 13
joints, 13
mast, 13
shoulder, 13
wrist, 13

BioCel System
Automation Control Unit, 8
components, 2
described, 2
device integration, 20
devices, 72
maintenance, 56
preparing for a run, 38
robot, 13, 33
shutting down, 30
starting up, 29

block diagrams, 147
bottle library, 144
BYPASS interlock setting, 9

C
cleanup procedure, 30
components of system, 2
compressed air

pressure regulation, 12
shutoff valve, 12
turning off, 31

computer, 2
described, 8
monitor, 8
monitor, adjusting angle of, 27
turning off, 30

context-sensitive help, ix

D
delidder air pressure regulator, 12
description

BioCel System, 2
Direct Drive Robot, 13

device files
adding devices, 33
creating, 21, 33
defined, 32
saving, 33

device stacking shelves, 72
devices, 40, 73

adding and removing docking table, 18
adding to device file, 33
Automation Control Unit, 72
Automation Solutions, 20
barcode reader, auxiliary, 72, 74
communicating with, 35
defined, 20, 32
deleting in software, 35
disabling and enabling, 35
initializing, 35
integration in system, 20
Labware MiniHub, 72
Lid Hotel Station, 72, 81
Linear Translator, 72, 88
Microplate Exchanger, 72
Orbital Shaking Station, 72, 101
Phantom Robot, 72, 107
Plate Hotel, 72, 111
Plate Hub Carousel, 72, 118
platepad, 73, 131
stacking shelves, 72
third-party, 20
turning off, 31
Vacuum Delid Station, 73, 134
waste bin, 73, 138
Weigh Pad, 73, 141

diagnostics software
described, 22
robot diagnostics, 22
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Index

Direct Drive Robot
axes, 13
described, 13
diagnostics, 22
elbow, 14
joints, 14
mast, 14
movements, 13
waist, 14
wrist, 14

docking tables
automated procedure, 44
described, 18
manual procedure, 46, 48
pendant for, 45
QuickDock feature, 44
windows for, 7, 42

dry runs, described, 39

E
elbow, robot, 13
EMERGENCY STOP

circuit, 150
errors

hardware, 64
plate-sensor, 63
reporting, 69, 70
servo, 61
teachpoint, 39

F
filtration station, 154
fuse, 64
fuses, 9, 149

G
gas supply, turning on, 30

H
hardware

errors, 64, 69

I
incubator device properties, 92
indicator lights, 9
interlock

air shutoff valve, 13
air system, 152
BYPASS mode, 9
NORMAL mode, 9
safety, 5, 6, 7, 8, 50
switch, 9

J
job roles for readers of this guide, vi
joints, robot, 13

K
keyboard shelf, adjusting, 26
knowledge base, viii

L
labware

definition, 21, 66
loading in system, 54
loading into Plate Hotel, 54
loading into Plate Hub Carousel, 54
orientation in system, 54

Labware MiniHub
described, 72

Lid Hotel Station
adding in device file, 82
described, 72, 81
profiles, 84
setting up, 81
status, 87
storage bays, 82, 83
teachpoints, setting, 85, 86

lid remover, 73, 134
Light Curtain, 6
Linear Translator, 72

adding in device file, 89
changing the speed, 99
described, 88
homing the plate stage, 97, 98
incubator device properties, 92
jogging the plate stage, 99
profiles, 93
teachpoints, setting, 96
teachpoints, verifying, 97
turning off the motors, 98
turning on the motors, 98

Linear Translator Robot Driver Diagnostics, 97
liquid

cabinet, 10, 56
container, 10
management, 10

liquid-handling tubing, 59

M
Machinery Directive, 10
main power, 149

switch, 9, 29
turning off, 31

maintenance, 56, 59
manifold, air distribution, 152
mast, 13
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Microplate Exchanger
described, 72

multi-color status lights, 14

N
network cards, 8
non-switched power, 150
NORMAL interlock setting, 9

O
online help, viii
Orbital Shaking Station, 72, 101

P
PDF guide, viii
Phantom Robot, 72

adding in software, 107
described, 107

pinch valve, 154
Plate Hotel, 72

adding in device file, 102
described, 111
loading, 54
profile, creating, 114
teachpoints, setting, 117, 130

Plate Hub Carousel, 72
adding in device file, 112, 119
described, 118
home position, setting, 128
loading, 54
profile, creating, 122
teachpoints, setting, 117, 130
turning the carousel, 129

Plate Hub Diagnostics, 128
plate sensor errors, 63
platepad, 73

adding in device file, 131
described, 131

plugins
loading, 34
storage location, 34

plumbing, 11
power

Automation Control Unit, 8
auxiliary, 149
block diagram, 148
connection, 64
outage, recovering from, 60
switch, 29
turning off, 30, 31
turning on, 29

pre-run checks, performing, 50
profiles

described, 22

selecting, 34
protocol runs

performing dry runs, 39
power outage, 60
setup guidelines, 40
starting, 21

Pump Module, 10

Q
QuickDock feature, 44

R
regulators, 152
Reload Plugins command, 34
reserve tank, 154
Reset button, 9, 150
robot

adding in device file, 33
axes (BenchBot Robot), 13
axes (Direct Drive Robot), 13
recovering from servo errors, 61

robot diagnostics, 22
robot gripper pads, maintaining, 59
robot power supply, 7
run

checks before starting, 50
during power outage, 60
monitoring, 14, 16
preparing for, 38

S
safety

flip-up doors, 5
general information, 4
Light Curtain, 6
sliding doors, 5
windows on docking tables, 7, 42

safety interlock, 6, 8
arming, 9, 50
bypassing, 9, 150

sensor
plate, 63
spill detection, 11

servo errors, recovering from, 61
setup workflow

system, 24
shoulder, robot, 13
shutdown procedure, 30
software

automation control, 21
described, 21
errors, 69
reporting errors, 69
version number, 69
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Index

spill-detection sensor, 11
Stacker, 72
stacking shelves for devices, 72
startup procedure, 29
status lights, 14, 16
storage, lids, 81

T
teachpoints

defined (all robots), 22
third-party devices, 20
trash door, 18
troubleshooting, 22, 55

hardware errors, 64

U
UPS, 8

connections, 149
turning off, 31
turning on, 29
using during power outage, 60

user accounts, 21
user guide

described, vi
related guides, vii

V
vacuum

creating, 152
system, 154

Vacuum Delid Station, 73
adding to software, 134
described, 134
teachpoints, setting, 137

Velocity parameter, 95

W
warning sounds, 16
waste bin, 73

adding door to device file, 140
adding to device file, 138
described, 138
replacing, 52

waste bottle, 154
Weigh Pad, 73

adding to device file, 142
bottle library, 144
bottle status, 146
calibrating, 145
described, 141
profile, creating, 142

Weigh Pad Diagnostics, 142
workflows

barcode reader setup, 74

Lid Hotel Station setup, 81
Linear Translator setup, 88
Plate Hotel setup, 101
Plate Hub Carousel setup, 107, 111, 119
preparing for a run, 38
system setup, 24
Vacuum Delid Station setup, 134
Weigh Pad setup, 141

wrist, robot, 13
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